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December 12, 2021 

NARA Unauthorized Disposition Complaint ICO NARA Expedite Processing 
Records of FOIA NARA-NGC-2022-000028

I. ALLEGATIONS.

I am alleging that National Archives Administration (NARA) either unlawfully destroyed 
records of its expedited processing denial of FOIA NARA-NGC-2022-000028 subject to 
preservation in their own right and also sought under expedited FOIA request NARA-NGC-
2022-000165 or made a false official statement in stating (in response to my FOIA Request 
NARA-NGC-2022-000165) that there are no records of said expedited processing denial of 
FOIA NARA-NGC-2022-000028 and unlawfully withheld records responsive to NARA-NGC-
2022-000165. (ATTACHMENT A. Final Disposition Notice 2021-12-01 063020 Letter. & 
Attachment B. FOIA NARA 22-M Expedited Processing NARA-NGC-2022-000028)  

Else, such records are in imminent danger of being destroyed. 

 It is impossible to issue an expedited processing denial without creating any records. 

Susan Gillett issued the expedited processing denial to NARA-NGC-2022-000028. Process flow 
and other records related to her actions are located within FOIAonline.gov. (Attachment A - 
FOIAonline Correspondence..NARA-NGC-2022-000028, Attachment C - Susan Gillet and 
Attachment D - FOIAonline_Agency_User_Guide). 

Jodi Foor processed FOIA Request NARA-NGC-2022-000165, and she stated that there were no 
records. Process flow and other records related to her actions are located within FOIAonline.gov. 
(FOIAonline Correspondence.NARA-NGC-2022-000165, Jodi Foor) 

If NARA claims that records exist and have not been destroyed, NARA has made a false official 
statement in response to my FOIA Request NARA-NGC-2022-000165 that there are no records 
of said expedited processing denial of FOIA NARA-NGC-2022-000028 and NARA’s 
Unauthorized Disposition staff must make a ... referral to OIG regarding the false official 
statement and unlawful withholding of FOIA records.  

Further, if NARA claims that records exist and have not been destroyed, this must be proven by 
NARA releasing the records pursuant to my FOIA request NARA-NGC-2022-000165, which 
NARA unlawfully withheld.  

Any potentially recoverable records are in imminent danger of the Agency destroying them. 

II. ACTION SOUGHT.

1. Notify the Agency within 5 working days.
2. Provide me a point of contact by return email to discuss this matter.



Page 2 of 6  

3. Permit me to discuss the Agency’s reply prior to deciding on this complaint to preclude 
the likely provision of misinformation, as has been done in the past.

4. If records have not been destroyed, seek that the Agency provide them to you as 
individual PDF files and the results of searches Note that all records sought in my FOIA 
request are FOIA case processing records that are required to be retained for 6+ years 
after the final action.

5. If NARA claims that records exist and have not been destroyed, NARA has made a false 
official statement in response to my FOIA Request NARA-NGC-2022-000165 that there 
are no records of said expedited processing denial of FOIA NARA-NGC-2022-000028 
and NARA’s Unauthorized Disposition staff must make a ... referral to OIG regarding 
the false official statement and unlawful withholding of FOIA records. 

III. IDENTIFICATION OF RECORDS.

(NARA) either unlawfully destroyed records of its expedited processing denial of FOIA NARA-
NGC-2022-000028 subject to preservation in their own right and also sought under expedited 
FOIA request NARA-NGC-2022-000165 or made a false official statement in stating (in 
response to my FOIA Request NARA-NGC-2022-000165 that there are no records of said 
expedited processing denial of FOIA NARA-NGC-2022-000028.  

RECORDS SOUGHT VIA FOIA Request NARA-NGC-2022-000165: 

FOIA Request NARA 22-M Expedited Processing NARA-NGC-2022-000028. 
See PDF. 

I am respectfully seeking: 
1. Records from 7 October 2021 to 15 October 2021 related to the NARA decision to

deny expedited processing for this subject case, FOIAonline NARA-NGC-2022-
000028. Records would include, but not be limited to:

a. Unredacted emails and other correspondence within the NARA FOIA Office.
b. Unredacted emails and other correspondence within the NARA Media or

Public Affairs Office or similar office by any other name.
c. Unredacted emails and other correspondence between the NARA FOAI

Office with any other office, including NARA’s Media or Public Affairs
Office or similar office by any other name.

d. Records of reviews conducted of the subject matter of the request for
expedited processing and the decision to deny expedited processing

NARA-NGC-2022-000165 Processing Records. Records of actions taken, process flow, etc., 
are located within FOIAonline.gov. The processor for this FOIA request was: 

Jodi Foor 
Deputy FOIA Officer 
Office of General Counsel 
National Archives and Records Administration 
foia@nara.gov 

mailto:foia@nara.gov
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NARA-NGC-2022-000028. Processing Records. Records of actions taken, process flow, 
etc., are located within FOIAonline.gov. The processor for this FOIA request expedited 
processing denial was: 
 

SUSAN GILLETT 
GOVERNMENT INFORMATION SPECIALIST 
OFFICE OF GENERAL COUNSEL 
NATIONAL ARCHIVES AND RECORDS ADMINISTRATION 
FOIA@NARA.GOV 

  
V. APPLICABLE RETENTION SCHEDULE, NARA GRS 4.2 Item 20 
 

020  Access and disclosure request files. Case files 
created in response to requests for information under 
the Freedom of Information Act (FOIA), Mandatory 
Declassification Review (MDR) process, Privacy Act 
(PA), Classification Challenge, and similar access 
programs, and completed by: • granting the request in 
full • granting the request in part • denying the request 
for any reason including: o inability to fulfill request 
because records do not exist o inability to fulfill 
request because request inadequately describes 
records o inability to fulfill request because search or 
reproduction fees are not paid  

Temporary. 
Destroy 6 years 
after final agency 
action or 3 years 
after final 
adjudication by the 
courts, whichever is 
later, but longer 
retention is 
authorized if 
required for 
business use.  

DAA-
GRS-
2016-
0002-
0001  

 

VI. 32 CFR PART 286—DOD FREEDOM OF INFORMATION ACT (FOIA) PROGRAM 

32 CFR §286.6   Preservation of records. 

Each DoD Component shall preserve all correspondence pertaining to the requests that it 
receives under this part, as well as copies of all requested records, until disposition or 
destruction is authorized pursuant to title 44 of the United States Code or the General 
Records Schedule 4.2 of the National Archives and Records Administration (NARA). 
Records shall not be disposed of or destroyed while they are the subject of a pending request, 
appeal, or lawsuit under the FOIA. 

VII. 36 CFR § 1230.3 

Unlawful or accidental destruction (also called unauthorized destruction) means disposal of 
an unscheduled or permanent record; disposal prior to the end of the NARA-approved 
retention period of a temporary record (other than court-ordered disposal under § 
1226.14(d) of this subchapter); and disposal of a record subject to a FOIA request, litigation 
hold, or any other hold requirement to retain the records. 

mailto:foia@nara.gov
https://www.law.cornell.edu/definitions/index.php?width=840&height=800&iframe=true&def_id=3d88a179580900933ecb2fd888be1e00&term_occur=999&term_src=Title:36:Chapter:XII:Subchapter:B:Part:1230:1230.3
https://www.law.cornell.edu/cfr/text/36/1226.14#d
https://www.law.cornell.edu/cfr/text/36/1226.14#d
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VIIII. 44 U.S. CODE § 3106 – UNLAWFUL REMOVAL, DESTRUCTION OF 
RECORDS 

(a) FEDERAL AGENCY NOTIFICATION.— 
The head of each Federal agency shall notify the Archivist of any actual, impending, or 
threatened unlawful removal, defacing, alteration, corruption, deletion, erasure, or other 
destruction of records in the custody of the agency, and with the assistance of the Archivist 
shall initiate action through the Attorney General for the recovery of records the head of the 
Federal agency knows or has reason to believe have been unlawfully removed from that 
agency, or from another Federal agency whose records have been transferred to the legal 
custody of that Federal agency. 
 
(b) ARCHIVIST NOTIFICATION.— 
In any case in which the head of a Federal agency does not initiate an action for such 
recovery or other redress within a reasonable period of time after being notified of any such 
unlawful action described in subsection (a), or is participating in, or believed to be 
participating in any such unlawful action, the Archivist shall request the Attorney General to 
initiate such an action, and shall notify the Congress when such a request has been made. 
(Pub. L. 90–620, Oct. 22, 1968, 82 Stat. 1298; Pub. L. 98–497, title I, § 107(b)(21), title II, 
§ 203(b), Oct. 19, 1984, 98 Stat. 2290, 2294; Pub. L. 113–187, § 4, Nov. 26, 2014, 128 Stat. 
2009.) 

 
X. IMPROPOERLY WITHHOLDING RECORDS 
 
Pursuant to FOIA:   

“Whenever the court orders the production of any agency records improperly 
withheld from the complainant and assesses against the United States reasonable 
attorney fees and other litigation costs, and the court additionally issues a written 
finding that the circumstances surrounding the withholding raise questions whether 
agency personnel acted arbitrarily or capriciously with respect to the withholding, 
the Special Counsel shall promptly initiate a proceeding to determine whether 
disciplinary action is warranted against the officer or employee who was primarily 
responsible for the withholding. The Special Counsel, after investigation and 
consideration of the evidence submitted, shall submit his findings and 
recommendations to the administrative authority of the agency concerned and shall 
send copies of the findings and recommendations to the officer or employee or his 
representative. The administrative authority shall take the corrective action that the 
Special Counsel recommends.”  5 U.S.C. § 552(a)(4)(F)(i). 
 

XI. PERJURY 

Whoever- 

(1) having taken an oath before a competent tribunal, officer, or person, in any case 
in which a law of the United States authorizes an oath to be administered, that he 
will testify, declare, depose, or certify truly, or that any written testimony, 
declaration, deposition, or certificate by him subscribed, is true, willfully and 

https://www.law.cornell.edu/rio/citation/Pub._L._90-620
https://www.law.cornell.edu/rio/citation/82_Stat._1298
https://www.law.cornell.edu/rio/citation/Pub._L._98-497
https://www.law.cornell.edu/rio/citation/98_Stat._2290
https://www.law.cornell.edu/rio/citation/Pub._L._113-187
https://www.law.cornell.edu/rio/citation/128_Stat._2009
https://www.law.cornell.edu/rio/citation/128_Stat._2009
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contrary to such oath states or subscribes any material matter which he does not 
believe to be true; or 

(2) in any declaration, certificate, verification, or statement under penalty of 
perjury as permitted under section 1746 of title 28, United States Code, willfully 
subscribes as true any material matter which he does not believe to be true; 

is guilty of perjury and shall, except as otherwise expressly provided by law, 
be fined under this title or imprisoned not more than five years, or both. This 
section is applicable whether the statement or subscription is made within or 
without the United States. 

18 U.S. C. § 1621 – Perjury generally (June 25, 1948, ch. 645, 62 Stat. 773; Pub. L. 88–
619, §1, Oct. 3, 1964, 78 Stat. 995 ; Pub. L. 94–550, §2, Oct. 18, 1976, 90 Stat. 2534 ; 
Pub. L. 103–322, title XXXIII, §330016(1)(I), Sept. 13, 1994, 108 Stat. 2147.  

XII. SUBORDINATION OF PERJURY 

The term subornation of perjury further describes the circumstance wherein an attorney at law 
causes a client to lie under oath or allows another party to lie under oath 

Title 18 U.S.C. § 1622 provides: 

Whoever procures another to commit any perjury is guilty of subornation of 
perjury, and shall be fined under this title or imprisoned not more than five years, 
or both. 

XIII. FALSE OFFICIAL STATEMENTS. 
18 U.S.C. § 1001. Statements or entries generally: 

a. Except as otherwise provided in this section, whoever, in any matter within the 
jurisdiction of the executive, legislative, or judicial branch of the Government of the 
United States, knowingly and willfully – 

1.falsifies, conceals, or covers up by any trick, scheme, or device a material fact; 
2.makes any materially false, fictitious, or fraudulent statement or representation; or 
3.makes or uses any false writing or document knowing the same to contain any 

materially false, fictitious, or fraudulent statement or entry; shall be fined under 
this title or imprisoned not more than 5 years, or both. 

10 U.S. Code § 907. Art. 107. False official statements; false swearing:  
(a) FALSE OFFICIAL STATEMENTS. Any person subject to this chapter who, with intent to 

deceive—  
(1) signs any false record, return, regulation, order, or other official document, 

knowing it to be false; or 
(2) makes any other false official statement knowing it to be false; 
 
shall be punished as a court-martial may direct.” 

 
This is submitted upon information, belief and records available to me. 

http://uscode.house.gov/statviewer.htm?volume=62&page=773
http://uscode.house.gov/statviewer.htm?volume=78&page=995
http://uscode.house.gov/statviewer.htm?volume=78&page=995
http://uscode.house.gov/statviewer.htm?volume=90&page=2534
http://uscode.house.gov/statviewer.htm?volume=108&page=2147
https://en.wikipedia.org/wiki/Lawyer
https://en.wikipedia.org/wiki/Title_18_of_the_United_States_Code
https://www.law.cornell.edu/uscode/text/18/1622
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With my respect, 
 
/s/ 
Robert Hammond                                              
Whistleblower 
Attachments: 

A. Final Disposition Notice 2021-12-01 063020 Letter 
B. FOIA NARA 22-M Expedited Processing NARA-NGC-2022-000028  
C. FOIAonline Correspondence..NARA-NGC-2022-000028, Susan Gillet 
D. FOIAonline_Agency_User_Guide 
E. FOIAonline Correspondence.NARA-NGC-2022-000165, Jodi Foor 

 
 



 
ATTACHMENT A 

 
Final Disposition Notice 2021-12-01 063020 Letter 

 



NARA-NGC-2022-000165 has been processed with the following final disposition: Full Grant for Part 2 of
your request.  No Records for Part 1 of your request.
 
December 1, 2021
 
Robert Hammond 
11828 Wayland Street  
Oakton, VA 22124
 
Re: Freedom of Information Act Request NGC22-101
 
Dear Mr. Hammond:
 
This is in response to your Freedom of Information Act (FOIA) request dated November 5, 2021, which
we received in our office on the same day via FOIAonline. Your request was assigned FOIAonline
tracking number NARA-NGC-2022-000165, and our office assigned your request the internal tracking
number NGC22-101. In your request, you stated:
 
I am respectfully seeking:
 
1. Records from 7 October 2021 to 15 October 2021 related to the NARA decision to 
deny expedited processing for this subject case, FOIAonline NARA-NGC-2022- 
000028. Records would include, but not be limited to: 
a. Unredacted emails and other correspondence within the NARA FOIA Office. 
b. Unredacted emails and other correspondence within the NARA Media or Public Affairs Office or similar
office by any other name. 
c. Unredacted emails and other correspondence between the NARA FOAI Office 
with any other office, including NARA’s Media or Public Affairs Office or 
similar office by any other name. 
d. Records of reviews conducted of the subject matter of the request for expedited 
processing and the decision to deny expedited processing 
2. I am also seeking a copy of this FOIA Request, which is an Agency record subject to 
FOIA that exists and is in the Agency’s possession at the time of my FOIA request. 
This record is a responsive record integral to my Request. Release of the Agency’s copy is not optional.
 
After conducting a search, no responsive records were located regarding your request.
 
As you are aware, NARA processes FOIA requests on an expedited basis if it is determined that the
requester has meet one or more of the following criteria described in its FOIA Regulation, at 36 C.F.R.
§1250.28:
 
(1) A reasonable expectation of an imminent threat to an individual’s life or physical safety;
 
(2) A reasonable expectation of an imminent loss of a substantial due process right;
 
(3) An urgent need to inform the public about an actual or alleged Federal Government activity (this
criterion applies only to those requests made by a person primarily engaged in disseminating information
to the public); or
 
(4) A matter of widespread and exceptional media interest in which there exist possible questions that
affect public confidence in the Government’s integrity.
 
The NGC staff member reviewed your request for expedition and determined that your request did not
meet the criteria cited in our regulations. Records were not created discussing the denial.
 
With respect to item two above, a copy of your request has been uploaded to the Responsive Records
section of your FOIAonline case file.
 
This completes the processing of your request.
 
If you are not satisfied with our action on this request, you have the right to file an administrative appeal
within ninety (90) calendar days from the date of this letter via regular U.S. mail or email. By filing an
appeal, you preserve your rights under FOIA and give the agency a chance to review and reconsider your
request and the agency’s decision. If you submit your appeal in writing, please address it to the Deputy



Archivist of the United States (ND), National Archives and Records Administration, 8601 Adelphi Road,
College Park, Maryland 20740. Both the letter and the envelope should be clearly marked “Freedom of
Information Act Appeal.” If you submit your appeal by e-mail please send it to FOIA@nara.gov, also
addressed to the Deputy Archivist of the United States. Please be sure to explain why you believe this
response does not meet the requirements of the FOIA. All correspondence should reference your case
tracking number NGC22-101 and the above noted FOIAonline tracking number.
 
If you would like to discuss our response before filing an appeal to attempt to resolve your dispute without
going through the appeals process, you may contact our FOIA Public Liaison Gary M. Stern for
assistance at:
 
National Archives and Records Administration 
8601 Adelphi Road, Room 3110 
College Park, MD 20740-6001 
(301) 837-1750 
garym.stern@nara.gov
 
You may also contact the Office of Government Information Services (OGIS), the Federal FOIA
Ombudsman’s office, for assistance. OGIS offers mediation services to help resolve disputes between
FOIA requesters and Federal agencies. The contact information for OGIS is:
 
Office of Government Information Services 
National Archives and Records Administration 
8601 Adelphi Road–OGIS 
College Park, MD 20740-6001 
Email: ogis@nara.gov  
https://www.archives.gov/ogis  
Phone: 202-741-5770 or 1-877-684-6448
 
Sincerely,
 
Jodi Foor 
Deputy FOIA Officer 
Office of General Counsel 
National Archives and Records Administration 
foia@nara.gov
 



 
ATTACHMENT B 

 
FOIA NARA 22-M Expedited Processing NARA-NGC-2022-000028 
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November 5, 2021 
 

Subject: FOIA Request NARA 22-M Expedited Processing NARA-NGC-2022-000028 
 
I am submitting this request under the Freedom of Information Act (“FOIA”), 5 U.S.C. § 
552 et seq., as amended. If you deny all or any part of this request, please cite each specific 
exemption you think justifies your decision not to release the information and notify me of 
appeal procedures available under the law. References cited below apply.  
 

***This Request will be timely for Judicial Review in twenty working days*** 
 
RECORDS SOUGHT VIA FOIA.  
 
FOIA Request NARA 22-M Expedited Processing NARA-NGC-2022-000028. 
See PDF. 
 
I am respectfully seeking: 

1. Records from 7 October 2021 to 15 October 2021 related to the NARA decision to 
deny expedited processing for this subject case, FOIAonline NARA-NGC-2022-
000028. Records would include, but not be limited to: 

a. Unredacted emails and other correspondence within the NARA FOIA Office. 
b. Unredacted emails and other correspondence within the NARA Media or Public 

Affairs Office or similar office by any other name. 
c. Unredacted emails and other correspondence between the NARA FOAI Office 

with any other office, including NARA’s Media or Public Affairs Office or 
similar office by any other name. 

d. Records of reviews conducted of the subject matter of the request for expedited 
processing and the dedision to deny expedited processing 

2. I am also seeking a copy of this FOIA Request, which is an Agency record subject to 
FOIA that exists and is in the Agency’s possession at the time of my FOIA request. 
This record is a responsive record integral to my Request. Release of the Agency’s 
copy is not optional. 

 
REQUESTED FORMAT.  
 
I am also seeking records in their native format (MS. Outlook, PowerPoint, Excel, ADA 
accessible PDF files by return email with: (1) a signed and dated cover letter (citing my 
personally assigned requester control number); (2) with record page count for all records 
released records (3) a copy of this request in your reply. I seek records via email in PDF format 
with an imbedded copy of my requests to (1) impede the agency from not addressing the FOIA 
Request; (2) impede the Agency from not providing the documents stated in the Agency’s 
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letter reply, and (3) make it obvious in any subsequent review what the Agency has or has not 
done.  
 
Further, I request that these records be sent in any digital formats in which they exist (such as PDF and 
Excel). Under the terms of the E-FOIA Amendments of 1996, Section 5, if a document exists in 
electronic format, it must be released in that format upon request. 
 
Each record must be provided as a distinct record in their native format. Emails should be provided as 
MS Outlook files, if not encrypted or otherwise unable to be open ed by me. Only if this is not possible, 
emails should be produced with their embedded hyperlinked attachments by using the “File => Save as 
Adobe PDF” command within Outlook or by other software that produces the same result. 
 
I am also seeking the “Description Available to the Public” field I FOIAonline be set to yes 
and that all records be released to and viewable in the application by the general Public. The 
release type must be set to “Unredacted – Releasable to the General Public: Will be 
available to the general public,” or to “Redacted – Releasable to the General Public: Will be 
available to the general public.” 
 
This request is distinctly separate from any other. Please do not combine this request with 
any other request in your reply. I am requesting that each element of the records sought be 
specifically addressed in the reply. 
 
FEE WAIVER/ PUBLIC INTEREST/PUBLIC RELEASE. Notwithstanding my agreement 
to pay fees below if my fee waiver is denied, I am seeking a fee waiver due to significant 
public interest in this information. The subject of the requested records concerns "the 
operations or activities of the government.” The disclosure is "likely to contribute" to an 
understanding of government operations or activities. There is no commercial interest. There is 
significant public interest.  
 
AGREEMENT TO PAY FEES.  
 
I agree to pay fees for searching or copying the records up to $25. If the fees exceed this 
amount please advise me of the cost before proceeding. I do not believe that there should be 
any charge for providing these records, as there is public interest in government operations. I 
am a private individual not seeking documents for commercial use, such that the following 
applies: “No fees may be charged by any DoD Component if the costs of routine collection and 
processing of the fee are likely to equal or exceed the amount of the fee. With the exception of 
requesters seeking documents for a commercial use, Components shall provide the first two 
hours of search time, and the first one hundred pages of duplication without charge.” I would 
note that because I am requesting an electronic file, there should not be a per page copy fee. 
The OMB Guidelines direct that searches for responsive records should be done in the "most 
efficient and least expensive manner." See OMB Fee Guidelines, 52 Fed. Reg. at 10,017. As an 
“all others” requester, I may only be assessed search and duplication fees and not fees for 
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review. See 32 CFR 286.12 - Schedule of fees. Also, please note that, should payment become 
necessary, the Coinage Act of 1965, specifically Section 31 U.S.C. 5103, entitled "Legal 
tender," states: " United States coins and currency (including Federal reserve notes and 
circulating notes of Federal reserve banks and national banks) are legal tender for all debts, 
public charges, taxes, and dues. Foreign gold or silver coins are not legal tender for debts. 
( Pub. L. 97–258, Sept. 13, 1982, 96 Stat. 980 ; Pub. L. 97–452, §1(19), Jan. 12, 1983, 96 Stat. 
2477 .) 

EXPEDITED PROCESSING.  

I am seeking expedited processing. The  subject is of widespread and exceptional media 
interest and the information sought involves possible questions about the government's 
integrity that affect public confidence.   

This matter relates to matters before the FOIA Advisory Committee reporting to the Archivist 
of the United States, including the inadequacy of OGIS budgets, OGIS Public Comments 
Posing Policy, the Mandatory Right to OGIS Dispute Resolution and others. Open meetings 
are viewed by thousands, including via permanently preserved You Tube videos. The is 
extensive public and media interest. 

Additionally, I am an individual/organization primarily engaged in the dissemination of 
information who can prove the information is urgently needed to inform the public concerning 
some actual or alleged government activity. My primary activity is informing the public, which 
I do through a variety of means, such as open meeting public comments, blogs, etc., and I may 
from time to time collaborate on articles. There is extraordinary, off the charts interest in the 
subject matter of this meeting and NARA’s execution. 
 
DOD POLICY – PUBLIC TRUST.   
  
Reference (c) states, “DoD personnel are expected to comply with the FOIA, this Regulation, 
and DoD FOIA policy in both letter and spirit. This strict adherence is necessary to provide 
uniformity in the implementation of the DoD FOIA Program and to create conditions that will 
promote public trust.”  
 
STILL-INTERESTED PREEMPTIVE REPLY.  This is a preemptive reply to the 
Justice Department guidelines the procedure known as a “still interested” inquiry, 
through which a FOIA officer can confirm that the requester has not lost interest in 
obtaining the documents. 
  
My interest in all FOIA requests submitted to your office is enduring, meaning that my 
interest in seeking replies to all past and future FOIA request remains in effect until each 
request has been answered fully and the time for judicial review has passed. Please do not 

https://uscode.house.gov/statviewer.htm?volume=96&page=980
https://uscode.house.gov/statviewer.htm?volume=96&page=2477
https://uscode.house.gov/statviewer.htm?volume=96&page=2477
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initiate any "still interested" inquiries. This serves as my notice of enduring interest and 
automatic reply to any future questions of interest by your office. There are no reasonable 
grounds to ever conclude in the future that I am not interested in this request. 
 
Implementation Checklist for DOJ OIP Guidance on “Still-Interested” Inquiries 

1. Ensure there are reasonable grounds to make a “still-interested” inquiry in first 
instance. 

2. Absent good cause, do not make multiple “still-interested” inquiries. 
3. Use requester’s preferred method of communication and in the absence of a preference, 

communicate by telephone or email as the default.  
4. Memorialize any decision by a requester to withdraw a request that is conveyed by 

telephone by sending the requester a brief email or letter noting the withdrawal. 
5. Provide requesters no less than thirty (30) working days to respond to the “still-

interested” inquiry and ensure that there is a simple way to do so. 
6. Advise the requester that if they elect not to respond to the inquiry, the request will be 

administratively closed at the conclusion of the designated time period (which must be 
at least 30 working days). 

7. Prior to administratively closing a request based upon the lack of a response by the 
requester, make good faith efforts to reach out to the requester using multiple methods 
of communication. 

8. In the event a requester responds to the “still- interested” inquiry within a reasonable 
time after the deadline has passed, reopen the request and place it back into the 
processing queue where it would have been. 

 
PRESERVE RECORDS AND SEARCHES FOR JUDICIAL REVIEW.  
 
Please search for, locate and preserve all responsive or potentially responsive records and 
records of your searches in your FOIA case file until the statutory date for judicial review has 
passed (should that be necessary) or in accordance with a NARA approved records schedule, if 
longer. NARA GRS 4.2 requires that FOIA and Privacy Act case files be retained for 6 years 
after final agency action or 3 years after final adjudication by the courts, whichever is later.  
Records of responsive searches would include but not be limited to: searches conducted for 
each specific record sought and all other records known to the Agency, including dates, 
manner of searching, responsible agent or employee conducting each search and the results 
thereof. Such persons determining the locations of responsive records must be inclusive of 
persons who would know such locations and their identities and manner of determining search 
locations must be preserved.  
 
In any subsequent proceedings, I may seek sworn declarations and a court order appointing a 
special counsel, as appropriate. Similarly, I may pursue additional venues.  
 
Any deletion of potentially responsive records by any party having knowledge of this Request 
may be a violation of law. In as much as applicable staff and leadership have knowledge of my 
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subject request, the Agency must search for, locate and preserve all responsive or potentially 
responsive records and records of searches in their FOIA case file, and leadership must ensure 
that this is done. Failing to do so and allowing records to be deleted IAW any other records 
management schedule may be a violation of law. 
 
ELECTRONIC RECORDS PRESERVATION. 
 
The Agency must preserve all electronically stored information, copies and backup, as defined 
by Rule 34 of the Federal Rules of Civil Procedure, along with any paper files which the 
Agency maintains, relevant to this action  I am seeking electronic data in the Agency’s custody 
and control that is relevant to this action, including without limitation emails, along with 
metadata, and other information contained on Agency computer systems and any electronic 
storage systems. I consider this electronic data and paper files to be valuable and irreplaceable 
sources of discoverable information in this matter.  No procedures should have been 
implemented to alter any active, deleted or fragmented data.  Moreover, no electronic data 
should have been disposed of or destroyed. (ETL Institute for Advancement of America’s 
Legal System).   
 
Further, to properly fulfill your preservation obligation, stop all scheduled data destruction, 
electronic shredding, rotation of backup tapes, and the sale, gift or destruction of hardware. 
Notify all individuals and of the need and duty to take the necessary affirmatives steps to 
comply with the duty to preserve evidence. (2008 Thomson Delmar Learning). 
 
The Agency’s Director of Information Operations or similar organization must initiate 
procedures to preserve electronic records. 
 
ALTERATION/DESTRUCTION OF RECORDS 
 
Whoever knowingly alters, destroys, mutilates, conceals, covers up, falsifies, or makes a false 
entry in any record, document, or tangible object with the intent to impede, obstruct, or 
influence the investigation or proper administration of any matter within the jurisdiction of any 
department or agency of the United States or any case filed under title 11, or in relation to or 
contemplation of any such matter or case, shall be fined under this title, imprisoned not more 
than 20 years, or both. 18 U.S. Code § 1519 - Destruction, alteration, or falsification of 
records. (Added Pub. L. 107–204, title VIII, §802(a), July 30, 2002, 116 Stat. 800.). 
 
18 U.S.C. 641 and 2071. The penalties for the unlawful or accidental removal, defacing, 
alteration, or destruction of Federal records or the attempt to do so, include a fine, 
imprisonment, or both (18 U.S.C. 641 and 2071). 

36 CFR § 1230 UNLAWFUL OR ACCIDENTAL REMOVAL, DEFACING, 
ALTERATION, OR DESTRUCTION OF RECORDS 
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§1230.3    

Unlawful or accidental destruction (also called unauthorized destruction) means disposal 
of an unscheduled or permanent record; disposal prior to the end of the NARA-approved 
retention period of a temporary record (other than court-ordered disposal under §1226.14(d) of 
this subchapter); and disposal of a record subject to a FOIA request, litigation hold, or any 
other hold requirement to retain the records. 

IMPROPOERLY WITHHOLDING RECORDS 
 
Pursuant to FOIA:   

“Whenever the court orders the production of any agency records improperly 
withheld from the complainant and assesses against the United States reasonable 
attorney fees and other litigation costs, and the court additionally issues a written 
finding that the circumstances surrounding the withholding raise questions whether 
agency personnel acted arbitrarily or capriciously with respect to the withholding, 
the Special Counsel shall promptly initiate a proceeding to determine whether 
disciplinary action is warranted against the officer or employee who was primarily 
responsible for the withholding. The Special Counsel, after investigation and 
consideration of the evidence submitted, shall submit his findings and 
recommendations to the administrative authority of the agency concerned and shall 
send copies of the findings and recommendations to the officer or employee or his 
representative. The administrative authority shall take the corrective action that the 
Special Counsel recommends.”  5 U.S.C. § 552(a)(4)(F)(i). 

 
LEGAL FRAMEWORK OF FOIA  
 

1. The definition of “records” includes:  
“[A]ill books, papers, maps, photographs, machine readable materials, or other 
documentary materials, regardless of physical form or characteristics, made or 

received by an agency of the United States Government under Federal law or in 
connection with the transaction of public business and preserved or appropriate 
for preservation by that agency or its legitimate successor as evidence of the 
organization, functions, policies, decisions, procedures, operations, or other 
activities of the Government or because of the informational value of data in 
them.”  44 U.S.C. § 3301 (emphasis supplied). 
2. FOIA requires that “each agency, upon any request for records which (i) 

reasonably describes such records and (ii) is made in accordance with published rules stating 
the time, place, fees (if any), and procedures to be followed, shall make the records promptly 
available to any person” 5 U.S.C. § 552(a)(3)(A). 

3. FOIA requires that “each agency shall establish a system to assign an 
individualized tracking number for each request received that will take longer than ten days to 
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process and provide to each person making a request the tracking number assigned to the 
request” 5 U.S.C. § 522(a)(7)(A). 

4. FOIA requires that each agency shall “establish a telephone line or Internet 
service that provides information about the status of a request to the person making the request 
using the assigned tracking number, including the date on which the agency originally received 
the request; and an estimated date on which the agency will complete action on the request. 5 
U.S.C. § 522(a)(7)(B). 

5. FOIA also requires federal agencies to make a final determination on 
FOIA administrative appeals that it receives within twenty days (excepting Saturdays, 
Sundays, and legal public holidays) after the receipt of such appeal, unless the agency 
expressly provides notice to the requester of “unusual circumstances” meriting 
additional time for responding to a FOIA request. 5 U.S.C. § 552(a)(6)(A)(ii). 

6. FOIA expressly provides that a person shall be deemed to have 
constructively exhausted their administrative remedies if the agency fails to comply 
with the applicable time limitations provided by 5 U.S.C. § 552(a)(6)(A)(I) - (ii). See 

also 5 U.S.C. § 552(a)(6)(C). 
7. FOIA provides that any person who has not been provided the 

records requested pursuant to FOIA, after exhausting their administrative remedies, 
may seek legal redress from the Federal District Court to enjoin the agency from 
withholding agency records and to order the production of any agency records 
improperly withheld from the complainant. 

8. Regarding he names of the FOIA requesters, the courts have held hat under 
the FOIA requesters do not have an expectation of privacy. Stauss v. IRS, 516 F. Supp. 
1218, 1223 (D.D.C. 1981), 

9. Under FOIA, the federal agency has the burden of sustaining its 
actions. 5 U.S.C.§ 552(a)(4)(B). 

10. Pursuant to FOIA, a Court may assess attorney fees and litigation 
costs against the United States if the Plaintiff prevails in an action thereunder.  5 
U.S.C. § 552(a)(4)(E). 

11. Department of Justice (DOJ) has issued a handbook addressing FOIA Annual 
Reports. See DOJ, Handbook for Agency Annual Freedom of Information Act Reports, 
“Disposition of FOIA Requests,” (available at 
http://www.justice.gov/sites/default/files/oip/pages/attachments/2014/11/04/department_of_jus
tice_handbook_for_agency_annual_freedom_of_information_act_reports.pdf) (“DOJ 
Handbook”).  

12. Among other things, the DOJ Handbook states, “All requests (perfected and 
non-perfected), appeals, and consultations that were pending at any time during the relevant 
fiscal year [October 1st through September 30th] will be captured.”  

13. The DOJ Handbook also states:  
“[E]ach agency is ultimately responsible for the accuracy and completeness of 
its Annual FOIA Report.  It is therefore essential for agencies to take steps that 
will ensure that they are adequately tracking all of the information necessary to 
complete the Annual FOIA Report sections detailed below. Agencies that utilize 

http://www.justice.gov/sites/default/files/oip/pages/attachments/2014/11/04/department_of_justice_handbook_for_agency_annual_freedom_of_information_act_reports.pdf
http://www.justice.gov/sites/default/files/oip/pages/attachments/2014/11/04/department_of_justice_handbook_for_agency_annual_freedom_of_information_act_reports.pdf
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a tracking or case management system for this purpose are responsible for 
ensuring that the system they are using can produce an accurate Annual FOIA 
Report that is in compliance with the law and Department of Justice guidance.” 
DOJ Handbook, at 3. 

 
I believe that I have adequately described the records that I am seeking. If you believe that my 
request is unclear, if you have any questions, or if there is anything else that you need from me 
to complete this request in a timely manner, please contact me in writing, so that I may perfect 
my request. If you deem that any portion of my request is unclear, answer the remaining 
portions and I will perfect a request for additional material as needed. 
 
Thank you very much in advance.  
 
With my respect, 
 
/s/ 
Robert Hammond  
Requester 
Whistleblower 
 
References:  

(a) The Freedom of Information Act (“FOIA”), 5 U.S.C. § 552 et seq., as 

amended, 
(b) Joint publication of U.S. Department of Justice, Executive Office of the President 

and U.S. General Services Administration of July 2011, “Your Right to Federal 
Records” 

(c) The Privacy Act (“PA”) of 1974, 5 U.S.C. § 552a, et seq., as amended 
(d) DoD 5400.11-R, May 14, 2007, Department of Defense Privacy Program 
(e) DoD 5400.7-R, September 1998, DoD Freedom of Information Act (FOIA) 

Program 
(f) DoD 6025.18-R, Jan. 24, 2003, DoD Health Information Privacy Regulation 
(g) GAO Report GAO-12-828 of July 2012, subject Freedom of Information Act 
(h) Department of Justice Handbook for Agency Annual Freedom of Information Act 

Reports 
(i) (b) Administrative Instruction 106, “Alternative Dispute Resolution (ADR) 

Program,” January 30, 2014 
(j) DoD Directive 5145.01, “General Counsel of the Department of Defense (GC 

DoD),” December 2, 2013, as amended  
(k)  DoD Directive 5145.04, “Defense Legal Services Agency (DLSA),” April 16, 2012 
(l) (f) DoD Directive 5400.11, “DoD Privacy Program,” October 29, 2014  
(m)  DoD Manual 8910.01, Volume 1, “DoD Information Collections Manual: 

Procedures for DoD Internal Information Collections,” June 30, 2014  
(n)  Executive Order 12988, “Civil Justice Reform,” February 5, 1996  
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(o) Public Law 101-552, “Administrative Dispute Resolution Act,” November 15, 1990  
(p) Public Law 104–320, “Administrative Dispute Resolution Act of 1996,” October 

19, 1996  
(q) Presidential Memorandum for Heads of Executive Departments and Agencies, 

“Designation of Interagency Committees to Facilitate and Encourage Agency Use 
of Alternate Means of Dispute Resolution and Negotiated Rulemaking,” May 1, 
1998 

(r) United States Code, Title 5 
(s) DoD Instruction 5145.05, “Alternative Dispute Resolution (ADR) and Conflict 

Management” 
(t) Alternate Dispute Resolution Handbook (opm.gov/policy-data-oversight/employee-

relations/employee-rights-appeals/alternative-dispute-resolution/handbook.pdf) 
(u) President Obama's FOIA Memorandum and Attorney General Holder's FOIA 

Guidelines (justice.gov/sites/default/files/oip/legacy/2014/07/23/foia-
memorandum.pdf)  
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Submitted Evaluation Assignment Processing Closed

NARA-NGC-2022-000028 Request Details

Correspondence

Detail

FOIA Request NARA-NGC-2022-000028 Submitted System 10/07/2021

Subject From Date 

−



Detail

This message is to confirm your request submission to the FOIAonline application: View Request . Request
information is as follows: Tracking Number: NARA-NGC-2022-000028 Requester Name: Mr. robert hammond Date
Submitted: 10/07/2021 Request Status: Submitted Description: NARA 22-A. Unlawful OGIS Dispute Resolution
Citations See PDF. I am respectfully seeking: 1. A copy of the documents with the first citation to OGIS dispute
Resolution Services in a FOIA determination letter or administrative appeal containing the language “If you would like
to discuss our response before filing an appeal to attempt to resolve your dispute without going through the appeals
process, you may contact our FOIA Public Liaison Gary M. Stern for assistance at: National Archives and Records
Administration 8601 Adelphi Road, Room 3110 College Park, MD 20740-6001 Tel: 301-837-1750 Email:
garym.stern@nara.gov If you are unable to resolve your FOIA dispute through our FOIA Public Liaison, the Office of
Government Information Services (OGIS), the Federal FOIA Ombudsman’s office, offers mediation services to help
resolve disputes between FOIA requesters and Federal agencies.” 2. Records of correspondence documenting who
suggested and authorized the change and why. 3. Records of any correspondence to other Agencies (including DOJ)
suggesting the use of the above language. 4. Records of any references to the above language in the Ombudsman
Blog. 5. Records of any references to the above language in any documents posted to NARA’s website including OGIS.
6. Among others responsive records would be held by and or known to Deputy Archivist of the U.S.
(debra.wall@nara.gov), FOIA NARA FOIA Liaison, (garym.stern@nara.gov) and OGIS Director (alina.semo@nara.gov).
7. While this is an inherently simple request, I am seeking that NARA release records as soon as they are located in
rolling responses. Further, there should be no redactions as to names, email addresses or phone numbers (excluding
cell numbers), which are not exempt under (b)(6) 8. I am also seeking a copy of this FOIA Request, which is an Agency
record subject to FOIA that exists and is in the Agency’s possession at the time of my FOIA request. This record is a
responsive record integral to my Request. Release of the Agency’s copy is not optional. REQUESTED FORMAT. I am also
seeking a single ADA accessible PDF file by return email with: (1) a signed and dated cover letter (citing my personally
assigned requester control number); (2) with record page count for all records released records (3) a copy of this
request in your reply. I seek records via email in PDF format with an imbedded copy of my requests to (1) impede the
agency from not addressing the FOIA Request; (2) impede the Agency from not providing the documents stated in the
Agency’s letter reply, and (3) make it obvious in any subsequent review what the Agency has or has not done Further, I
request that these records be sent in any digital formats in which they exist (such as PDF and Excel). Under the terms
of the E-FOIA Amendments of 1996, Section 5, if a document exists in electronic format, it must be released in that
format upon request. Each record must be provided as a distinct record in their native format. Emails should be
provided as MS Outlook files, if not encrypted or otherwise unable to be open ed by me. Only if this is not possible,
emails should be produced with their embedded hyperlinked attachments by using the “File => Save as Adobe PDF”
command within Outlook or by other software that produces the same result. I am also seeking a FOIAonline.gov
email link that makes all FOIAonline tabs and files publicly accessible by anyone. This request is distinctly separate
from any other. Please do not combine this request with any other request in your reply. I am requesting that each
element of the records sought be specifically addressed in the reply.

FOIA Expedited Processing Disposition Reached for NARA-NGC-2022-000028 System 10/15/2021

Your request for Expedited Processing for the FOIA request NARA-NGC-2022-000028 has been denied. Additional
details for this request are as follows: Request Created on: 10/07/2021 Request Description: NARA 22-A. Unlawful OGIS
Dispute Resolution Citations See PDF. I am respectfully seeking: 1. A copy of the documents with the first citation to
OGIS dispute Resolution Services in a FOIA determination letter or administrative appeal containing the language “If
you would like to discuss our response before filing an appeal to attempt to resolve your dispute without going
through the appeals process, you may contact our FOIA Public Liaison Gary M. Stern for assistance at: National
Archives and Records Administration 8601 Adelphi Road, Room 3110 College Park, MD 20740-6001 Tel: 301-837-1750
Email: garym.stern@nara.gov If you are unable to resolve your FOIA dispute through our FOIA Public Liaison, the

Subject From Date 

−



Detail

Office of Government Information Services (OGIS), the Federal FOIA Ombudsman’s office, offers mediation services to
help resolve disputes between FOIA requesters and Federal agencies.” 2. Records of correspondence documenting
who suggested and authorized the change and why. 3. Records of any correspondence to other Agencies (including
DOJ) suggesting the use of the above language. 4. Records of any references to the above language in the
Ombudsman Blog. 5. Records of any references to the above language in any documents posted to NARA’s website
including OGIS. 6. Among others responsive records would be held by and or known to Deputy Archivist of the U.S.
(debra.wall@nara.gov), FOIA NARA FOIA Liaison, (garym.stern@nara.gov) and OGIS Director (alina.semo@nara.gov).
7. While this is an inherently simple request, I am seeking that NARA release records as soon as they are located in
rolling responses. Further, there should be no redactions as to names, email addresses or phone numbers (excluding
cell numbers), which are not exempt under (b)(6) 8. I am also seeking a copy of this FOIA Request, which is an Agency
record subject to FOIA that exists and is in the Agency’s possession at the time of my FOIA request. This record is a
responsive record integral to my Request. Release of the Agency’s copy is not optional. REQUESTED FORMAT. I am also
seeking a single ADA accessible PDF file by return email with: (1) a signed and dated cover letter (citing my personally
assigned requester control number); (2) with record page count for all records released records (3) a copy of this
request in your reply. I seek records via email in PDF format with an imbedded copy of my requests to (1) impede the
agency from not addressing the FOIA Request; (2) impede the Agency from not providing the documents stated in the
Agency’s letter reply, and (3) make it obvious in any subsequent review what the Agency has or has not done Further, I
request that these records be sent in any digital formats in which they exist (such as PDF and Excel). Under the terms
of the E-FOIA Amendments of 1996, Section 5, if a document exists in electronic format, it must be released in that
format upon request. Each record must be provided as a distinct record in their native format. Emails should be
provided as MS Outlook files, if not encrypted or otherwise unable to be open ed by me. Only if this is not possible,
emails should be produced with their embedded hyperlinked attachments by using the “File => Save as Adobe PDF”
command within Outlook or by other software that produces the same result. I am also seeking a FOIAonline.gov
email link that makes all FOIAonline tabs and files publicly accessible by anyone. This request is distinctly separate
from any other. Please do not combine this request with any other request in your reply. I am requesting that each
element of the records sought be specifically addressed in the reply. Expedited Processing Original Justification:
AGREEMENT TO PAY FEES. I agree to pay fees for searching or copying the records up to $25. If the fees exceed this
amount please advise me of the cost before proceeding. I do not believe that there should be any charge for providing
these records, as there is public interest in government operations. I am a private individual not seeking documents
for commercial use, such that the following applies: “No fees may be charged by any DoD Component if the costs of
routine collection and processing of the fee are likely to equal or exceed the amount of the fee. With the exception of
requesters seeking documents for a commercial use, Components shall provide the first two hours of search time,
and the first one hundred pages of duplication without charge.” I would note that because I am requesting an
electronic file, there should not be a per page copy fee. The OMB Guidelines direct that searches for responsive
records should be done in the "most efficient and least expensive manner." See OMB Fee Guidelines, 52 Fed. Reg. at
10,017. As an “all others” requester, I may only be assessed search and duplication fees and not fees for review. See 32
CFR 286.12 - Schedule of fees. Also, please note that, should payment become necessary, the Coinage Act of 1965,
specifically Section 31 U.S.C. 5103, entitled "Legal tender," states: " United States coins and currency (including
Federal reserve notes and circulating notes of Federal reserve banks and national banks) are legal tender for all debts,
public charges, taxes, and dues. Foreign gold or silver coins are not legal tender for debts. ( Pub. L. 97–258, Sept. 13,
1982, 96 Stat. 980 ; Pub. L. 97–452, §1(19), Jan. 12, 1983, 96 Stat. 2477 .) EXPEDITED PROCESSING. I am seeking
expedited processing. The subject is of widespread and exceptional media interest and the information sought
involves possible questions about the government's integrity that affect public confidence. This matter relates to
matters before the FOIA Advisory Committee reporting to the Archivist of the United States, including the inadequacy
of OGIS budgets, OGIS Public Comments Posing Policy, the Mandatory Right to OGIS Dispute Resolution and others.
Open meetings are viewed by thousands, including via permanently preserved You Tube videos. The is extensive
public and media interest. The citation to OGIS dispute resolution appears intended to reduce OGIS workload and is

Subject From Date 



Detail

clearly in violation of law as discussed below 1. NARA appears to be attempting to make OGIS mediation workload go
away by first unlawfully requiring the requester to contact the Agency’s FOIA Public Liaison. 2. Improper citation of
OGIS Dispute Resolution Rights that does not comport with law or OGIS & DOJ policy. a. The Agency’s final disposition
letter states that I must contact the Agency’s FOIA Public Liaison before seeking mediation services through OGIS,
which does not comport with law or DOJ and OGIS policy. The letter states: “If you are unable to resolve your FOIA
dispute through our FOIA Public Liaison, the Office of Government Information Services (OGIS), the Federal FOIA
Ombudsman’s office, offers mediation services to help resolve disputes between FOIA requesters and Federal
agencies.” b. The FOIA statute is clear that OGIS dispute resolution does not first require FPL: shall immediately notify
the person making such a request of – […] (II) the right of such person to seek assistance from the FOIA Public Liaison
of the agency; and (III) in the case of an adverse determination – … (bb) the right of such person to seek dispute
resolution services from the FOIA Public Liaison of the agency or the Office of Government Information Services; and
… 3. In violation of OGIS and DOJ FOIA policy and the Administrative Procedures Act, OGIS is not following its own
model language per below: Suggested language for initial determination letters: “The new law says that in cases of
adverse determinations, agencies shall notify requesters of the right of the person to appeal and to “to seek dispute
resolution services from the FOIA Public Liaison of the agency or the Office of Government Information Services.” 5
U.S.C. § 552 (a)(6)(A)(i)(III). You may contact [optional: the analyst who processed your request and/or the FOIA
Requester Service Center, as well as] our FOIA Public Liaison, [name], for any further assistance and to discuss any
aspect of your request at: [Mailing address] [Telephone number] [Email address] [Fax number, if applicable]
Additionally, you may contact the Office of Government Information Services (OGIS) at the National Archives and
Records Administration to inquire about the FOIA mediation services they offer. The contact information for OGIS is as
follows: Office of Government Information Services, National Archives and Records Administration, 8601 Adelphi
Road-OGIS, College Park, Maryland 20740-6001, e-mail at ogis@nara.gov; telephone at 202-741-5770; toll free at 1-
877-684-6448; or facsimile at 202-741-5769.” Expedited Processing Disposition Reason: The requester has not
provided sufficient information to establish he meets one of the criteria required under the National Archives and
Records Administration (NARA) regulation 36 C.F.R. 1250.28 (a) and (c) to justify expedited processing. See letter in
Correspondence section of this FOIAonline case file. If you are not satisfied with our action on your request for
expedited processing, you have the right to file an administrative appeal in writing by mail or email. If by mail, please
address your appeal to the Deputy Archivist (ND), National Archives and Records Administration, 8601 Adelphi Rd.,
College Park, Maryland 20740. Both the letter and the envelope should be clearly marked “Freedom of Information
Act Appeal.” If by email, please submit your appeal to FOIA@nara.gov addressed to the Deputy Archivist. Your appeal
should be received within 90 calendar days of the date of this denial, and it should explain why you think this
response does not meet the requirements of the FOIA. If you would like to discuss our response before filing an
appeal to attempt to resolve your dispute without going through the appeals process, you may contact our FOIA
Public Liaison Gary M. Stern for assistance via email at garym.stern@nara.gov . You may also contact the Office of
Government Information Services (OGIS), the Federal FOIA Ombudsman’s office, which offers mediation services to
help resolve disputes between FOIA requesters and Federal agencies. The contact information for OGIS is noted
below: Office of Government Information Services National Archives and Records Administration 8601 Adelphi Road–
OGIS College Park, MD 20740-6001 Email: ogis@nara.gov Website: ogis.archives.gov Tel: 202-741-5770 or 1-877-684-
6448

Response to your request for Expedited Processing Susan Gillett 10/15/2021

Please see the attached letter. 

2021.10.15 Denial of Expedited Processing.pdf

Reply

Subject From Date 

−

https://foiaonline.gov/foiaonline/api/request/downloadFile/2021.10.15%20Denial%20of%20Expedited%20Processing.pdf/42d2a52f-0104-4c3b-8d7c-e068181ae101
15713
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1 Submitting a Request 
The public has the ability to submit FOIA requests in the system, but requesters may choose to bypass the 
system and submit requests to your office either via mail, fax, or email. As an agency user, you can manually 
enter the request into FOIAonline to make it available for tracking and reporting purposes. 
Have a frequent requester who continues to submit requests outside of the system? Pre-populate a frequent 
requester’s contact information by locating a previously submitted request and duplicate their contact 
information on a new Create Request form (1.2). 

1.1 New Requester Steps 
The following steps are required of an agency user for requests submitted outside of FOIAonline from a new or 
infrequent requester: 
 

1. While on any of the three dashboards, click the New Request link in the left-side menu. 

 
Exhibit 1-1 Enter Request Received Offline 

2. Conditionally Required: Select a Sub-Agency to route the request. Upon submission, the request 
will display in this office’s Unassigned Cases dashboard. (Note: You can only enter requests 
within FOIAonline for your agency.) 

3. Enter the Submitted Date, which can be backdated as far back as necessary. 

4. Optional – Enter the Perfected Date, which can also be backdated. 

*Note: Once the Perfected Date is set, it cannot be unset. The processing clock will begin. This 
field cannot contain a date that is prior to the Submitted Date. 

5. Enter the requester’s full name, mailing address, and any additional fields provided. 

*Note: If an email address is provided by the requester and it is entered on this page, then the 
requester will receive a system email confirmation with their tracking number. If you would like 
to bypass this notification but still have their email address on file, then enter the email address 
via the Edit Requester Information page (2.1) after the request is submitted. 

 

1 
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Exhibit 1-2 Create Request Page: Agency Selection and Contact Information 

 

6. Enter the requester provided Fee Limit. 
7. Enter the requester provided Description of records. 

 
Exhibit 1-3 Create Request Page: Processing Fees and Description 
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8. Optional – If the requester has requested either a fee waiver and/or expedited processing, then 
switch the applicable drop-downs to Yes. This will display a free text field for you to enter the 
requester’s justification. You will also be required to select a date of the submission. 
 

*Note: Upon indicating either fee waiver or expedited processing, these will display in the 
dashboard as a task, which will have the same tracking number as the request. This allows either 
of these items to be separately evaluated and assigned from the request. Track the status of these 
tasks by viewing the Assigned Tasks tab (2.5). 
 

9. Optional – Upload any supporting documents provided by the requester, which can include an 
electronic copy of the original request. 

10. Press the Preview button to display the Preview page. 

 
Exhibit 1-4 Create Request Page: Request Fee Waiver, Request Expedited Processing,  

and Attach Supporting Files 
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11. Optional: Press the Edit Request button to return to the previous page and modify any 
information. 

12. Press the Submit button. 

 
Exhibit 1-5 Preview Request Page 

1.2 Frequent Requester Steps 
Have a frequent requester? Save time entering in their contact information by searching for a previously 
created request in FOIAonline and pulling up the Request Details page. 

1. Click the duplication icon next to the requester’s name on the Request Details page to pre-
populate the Create Request page with their contact information. 
*Note: You will be able to edit the requester’s contact information that is pre-populated on the 
Create Request form, unless the requester has a registered user account. 

2. Complete steps 6-12 listed above. 

 
Exhibit 1-6 Frequent Requesters - Duplication Icon 
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1.3 Request Creation Summary 
Agency users can enter FOIA request information for requesters who submit outside of FOIAonline. These 
requests are routed in the same manner as when they are submitted by the public – the request will display in 
the Unassigned Cases dashboard of the agency or sub-agency that is specified on the Create Request page. 
Entering an email address for the requester will send the individual an email confirmation upon submission. 
For requesters who frequently submit their requests offline, agency users can pre-populate the Create Request 
form with their contact information from a previous request by using the duplication icon. 
Upon submission, the tracking number will be publicly available. Depending on your agency’s configuration, 
the requester name, organization, description of records, and any supporting attachments may default to being 
withheld from the public. See section 2.2 Submission Details Tab for steps on how to flip the switch to make 
any or all of that information publicly available. The public will always be able to view the Tracking Number, 
phase diagram, and due date of any request in the system. 
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2 Navigating the Request Details Page 
2.1 Edit Requester Contact Information 
Contact information can be modified from the Request Details page for public users who do not have a 
registered account with FOIAonline. 

1. Verify the requester does not have an account by viewing the Requester Has Account 
field. 
*Note: Requesters with a registered account are responsible for updating their contact 
information. 

2. Click the show all details icon. 

3. Click the pencil icon. 

 
Exhibit 2-1 Edit Requester Contact Information 

4. Modify the requester’s contact information and/or Fee Limit, as necessary. 

5. Press the Save Changes button. 
2.2 Submission Details Tab 
The Submission Details tab contains all fields necessary for evaluation and is divided into three sections: 
Request Handling, Request Description, and Attached Supporting Files. In order to save modifications made on 
the Submission Details tab, press the Save Changes button at the bottom of the page (see section 2.2.3 
Attached Supporting Files). 
2.2.1 Request Handling 
The Request Handling section contains a variety of fields necessary for request evaluation, including: the toggle 
to make the requester name publicly available, the request track, the requester’s fee category, fee waiver and 
expedited processing tracking, and perfection. 

1. Requester Info Available to the Public controls whether the requester name and organization 
are visible to the general public when viewing the request. 

2. Request Track contains the values Simple and Complex. This field allows you to filter requests 
on the dashboard by the value selected and is used for reporting metrics. 
*Note: If expedited processing is granted, then Expedited will display here and it is no longer 
modifiable. Expedited requests display at the top of the dashboard. 

1 
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3. Fee Category contains the values Commercial, Media/Educational, and Other. The selection 
made here deducts applicable discounts from the Admin Cost tab (9) for the invoice (18). 
Commercial requesters are charged for all search, review, and duplication. 
Media/Educational requesters are charged for duplication, excluding the cost of the first 100 
pages. 
Other requesters are are charged search and duplication, excluding the cost of the first 2 hours of 
search and the first 100 pages. 

4. Fee Waiver Requested tracks whether the requester submitted a fee waiver request at the time 
of submission. 
*Note: If “No,” then a pencil icon displays. Click the pencil icon to create a fee waiver task, if 
necessary. 

5. Fee Waiver Status tracks the disposition of the fee waiver task, if the fee waiver was requested. 
If it was not requested, then “N/A” displays. 

6. Expedited Processing Requested tracks whether the requester submitted an expedited 
processing request at the time of submission. 
*Note: If “No,” then a pencil icon displays. Click the pencil icon to create an expedited 
processing task, if necessary. 

7. Expedited Processing Status tracks the disposition of the expedited processing task, if one 
exists. If one does not exist, then “N/A” displays. 

8. Request Perfected field displays a drop-down for unperfected requests, which always defaults 
to No. Once the request is perfected, this field becomes read-only and the request cannot be 
unperfected. 

9. Perfected Date is the date the request was perfected. This can be backdated, if necessary, at the 
time of perfection. Once the Request Perfected field is set to Yes, this field cannot be modified. 

10. Acknowledgment Sent Date is an optional field to indicate when the acknowledgment letter, if 
applicable, was sent to the requester. 

11. Unusual Circumstances? is tied directly to the Extend the Due Date action item (8). When the 
due date is extended due to unusual circumstances, that is indicated on the main page of the 
request. 

12. 5 Day Notifications sends a system notification to the assigned individual every 5 days the 
request is pending. 

13. Litigation indicates if litigation has occurred. Select Yes from the drop-down to display the 
Court Docket Number field. A Court Docket Number is required when indicating litigation. 
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Exhibit 2-2 Submission Details - Request Handling 

2.2.2 Request Description 
The request description is always withheld from the public initially but making the description available to the 
public has the potential to reduce the number of future requests. 

1. Short Description is an optional free-text field that is only visible to the agency users. 
Text entered here displays when hovering over the tracking number while on the dashboard. 

2. The Description displays as read-only. 
*Note: Text entered in this field can never be changed. If the description needs to be modified, 
then see item #4, the Has Description Been Modified? checkbox. 

3. Description Available to the Public flag is set to No on default. Set this flag to Yes in order to 
make the description publicly searchable and viewable. 

4. Check the Has Request Been Modified? checkbox to display a free text field that automatically 
populates with the original request description, but can be modified as necessary. The original 
description will always be preserved. 
*Note: If the Description Available to the Public flag is set to Yes and the description has been 
modified, then the modified description displays to the public. 

 
Exhibit 2-3 Submission Details - Request Description 
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2.2.3 Attached Supporting Files 
The Attached Supporting Files section contains all attachments provided by the requester at the time of 
submission. These attachments can include additional justification for the request description, fee waiver and/or 
expedited processing, and/or an electronic copy of the original request. 
Any files uploaded here are available to requesters with registered user accounts, regardless of the value 
selected in the Attachments Available to the Public drop-down. 

1. Attachments Available to the Public drop-down controls whether or not the attached files will 
be viewable to the general public. This drop-down will default to No. 

2. The Remove icon displays a prompt, asking you if you would like to delete the selected file. 
3. The Select Files button in the Upload Supporting Files section allows you to select one or more 

files from your computer. Selected files display within the section and are only uploaded to the 
Attached Supporting Files section upon pressing the Save Changes button. 

4. Press the Save Changes button to save any modifications made on the Submission Details tab. 

 
Exhibit 2-4 Submission Details - Attached Supporting Files 
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2.3 Case File Tab 
The Case File tab contains a direct URL to the case, case specific information, and a series of sub-tabs that store 
responsive records, consultations, correspondence, appeals, invoices, and restricted materials (2.3.1-2.3.6). Case 
information displays as the following fields in the Case Details section: 

1. Type of Case displays that this is a FOIA case. 
2. Fiscal Year displays the fiscal year in which the request was submitted. 
3. Total Days Pending is the total number of days the request has been open. 
4. Final Disposition displays the final disposition that has been assigned to a case. 
5. Other Disposition displays an agency approved “Other” disposition that has been assigned to a 

case. 
*Note-Both the Final and Other Disposition fields only display once the close-out process has 
begun. 

6. Received Date is based on the business day the request was received. If the request was 
submitted to FOIAonline at 5:01pm EST on a Friday, then the Received Date would be the 
following Monday. 
*Note-This field is designated as the Business Date of Receipt for appeals. 

7. Clock Initially Started On is the date the clock began, either manually during perfection or if 
the 10-day clock auto-start began. 

8. Closed Date is the date the Final Disposition Notice was closed and the case completed. 
*Note-This field only displays once the close-out process has been completed. 

 
Exhibit 2-5 Case Details - Final Preparation of Response

2.3.1 Records Sub-Tab 
Case Responsive Records displays all records uploaded to the case file via the Upload Responsive Records 
action item. This includes all release types, which includes: redacted and unredacted, releasable and unreleasable, 
and releasable to the requester only (10). 
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2.3.2 Consultations Sub-Tab 
The Consultations sub-tab displays all pending and closed consultations created off of the request to system 
participating agencies. 

 
Exhibit 2-6 Case File - Consultation Sub-Tab 

2.3.3 Correspondence Sub-Tab 
The Correspondence sub-tab contains all correspondence sent to the requester via email and all files related to 
correspondence (14). 

2.3.4 Appeals Sub-Tab 
All appeals created off the request are linked via the Appeals sub-tab. If a request is appealed, then “Appealed” 
text will display next to the request’s status. Appeals have unique tracking numbers. 
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2.3.5 Financing Sub-Tab 
The Financing sub-tab contains information pertaining to any cost estimates sent to the requester, all invoices 
generated (18), and any payments received from the requester. 

 
Exhibit 2-7 Case File - Financing Sub-Tab 
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2.3.6 Restricted Materials Sub-Tab 
The Restricted Materials sub-tab can contain files that only individuals within your immediate office should be 
able to view. Individuals who exist organizationally outside your office, either above or below, cannot see any 
items that are uploaded to this section. 

1. Press the Restricted Materials tab to view and upload Restricted Materials. 
2. Press the Select Files button to select files to upload. 
3. Press the Save Changes button to add the files to the Restricted Materials section. 

 
Exhibit 2-8 Restricted Materials Sub-Tab 

2.4 Admin Cost Tab 
The Admin Cost tab displays all billable and non-billable time entered by users who performed processing work 
on the request (9). 

2.5 Assigned Tasks Tab 
The Assigned Tasks tab aggregates all system-generated and user-generated tasks created off the request (12). 

2.6 Comments Tab 
The Comments tab is an agency-user-only processing journal (15). 

2.7 Review Tab 
The Review tab is the staging area for the case file review workflow. See sections 16 Add Reviewer and 19.2 
Case File Review Steps for more information.
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3 Making Assignments 
A newly submitted request exists in the Unassigned Cases dashboard of the specified organization, which is a 
group box. In order to prevent multiple individuals simultaneously processing the same request, requests should 
be assigned out of the group box as quickly as possible. This can be accomplished through the Make 
Assignment page, which displays in the following areas in the system: 

1. Unassigned Cases dashboard, 
2. Click the Make Assignment action item from the left-side menu on the Request Details page, and 
3. The Make Assignment section displays at the bottom of the Custom Report Results. 

Options 1 and 3 allow you to assign multiple items (requests, tasks, appeals, consultations, and referrals) to a 
single individual or organization at the same time. 
The three assignment options are to yourself (3.1 Assign to Me), to another component (Assign to an 
Organization), or to an individual within your component (3.3 Assign to an Individual). If any tasks exist, then 
the tasks will not be assigned at the same time, but tasks can be assigned using the same processing steps. You 
cannot reassign any tasks currently assigned outside of your component. 
Comments can be added directly to requests via the Make Assignment page that will populate the request’s 
Comments tab (2.6). Comments added to tasks via the Make Assignment page will trickle up to the request. 

3.1 Assign to Me 
1. If you are on the Request Details Page: Click the Make Assignment action item from the left-

side menu 
If you are on either the Unassigned Cases Dashboard or Custom Report Results: select the 
items to assign by checking the Assign checkboxes in the left-most column. 

2. Press the Assign To Me button to assign the request to your user account. The request is now 
accessible via your My Cases dashboard. 

 
Exhibit 3-1 Assign to Me 
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3.2 Assign to an Organization 
1. If you are on the Request Details Page: Click the Make Assignment action item from the left-

side menu. 
If you are on either the Unassigned Cases Dashboard or Custom Report Results: select the 
items to assign by checking the Assign checkboxes in the left-most column. 

2. Click the person icon next to the Organization Assignment field to launch the Select 
Organization popup. 

 
Exhibit 3-2 Make Organization/Individual Assignment 

3. Enter text in either the Acronym or Name field.  
*Note: The user's acting agency acronym is automatically entered in the Acronym field and sub-
agencies display in the search results. This can be re-filtered by modifying the text. 

4. Press the Search button. 
5. Click the radio button for the desired organization in the first column. Only one organization 

can be selected at a time. 
*Note: Only 5 results display at one time. Use the pagination icons to flip through the results if 
more than 5 items exist. 

6. Press the Select button. 

2 
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Exhibit 3-3 Organization Lookup 

7. Optional - Enter a comment that will display in two places: 1. The assignment notification email 
and 2. The Comments tab (15 Creating Comments). 

8. Press the Save Changes button to send the item(s) to the Unassigned Cases dashboard of the 
chosen organization. 
*Note: The FOIA Officer will receive a system assignment notification if their Case File 
Modification Alerts item is enabled on the My Account page. 

 
Exhibit 3-4 Make Organization Assignment 
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3.3 Assign to an Individual 
1. If you are on the Request Details Page: Click the Make Assignment action item from the left-

side menu. 
If you are on either the Unassigned Cases Dashboard or Custom Report Results: select the 
items to assign by checking the Assign checkboxes in the left-most column. 

2. Click the Individual Assignment field or person icon to open the Select Individual lookup. 

 
Exhibit 3-5 Make Individual Assignment 

3. Enter information into any of the following three fields to search for an individual: Name, 
Organization Acronym, and/or Organization Name. 

4. Press the Search button. 
5. Click a radio button for an individual in the first column. Only one individual can be selected at 

a time. 

6. Press the Select button. 
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Exhibit 3-6 Individual Lookup 

7. Optional – If the selected individual has multiple actual agencies, then a popup will display with 
the Available Actual Agencies section. Click the radio button to the left of the desired agency 
and press the Select button. 

 

Exhibit 3-7 Available Actual Agencies 

8. Optional – Select the 5 Day Notifications checkbox to send email notifications to the assignee 
every 5 days. 
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9. Optional – Enter a comment, which will display in the assignment notification email and the 
Comments tab (15). 

10. Press the Save Changes button. 

 
Exhibit 3-8 Make Assignment to Individual 

 

11. Optional – Click the Click Here hyperlink in the message to return to the Request Detail page. 

 
Exhibit 3-9 Assignment Confirmation 

3.4 Summary 
Making assignments is important in ensuring an individual takes responsibility for a request. Assigning to the 
user's own account allows for quick ownership of a request for immediate processing. Assigning to other 
individuals or organizations allows for ownership by those deemed appropriate to fulfill the request. When an 
assignment has been made to an individual, the request displays in their My Cases dashboard as well as the 
Assigned Cases dashboard for the individual who assigned the request. When an assignment has been made to 
an organization, the request displays in the Unassigned Cases dashboard for users in that organization. While 
there must be one assignee to a request, multiple parties may contribute to the request processing through the 
Create Task (12) function. 
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4 Perfecting a Request 
A perfected request is one that is considered to reasonably describe the records sought and adheres to agency 
regulations related to request processing. While perfection is not a requirement to close-out a request, certain 
processing action items are only available to a perfected request. In most instances if a request is not yet 
perfected, then the text “(Never Started)” displays next to the number of days on the clock. Users should 
ensure that the perfected designation and perfected date are accurate before saving as a perfected request 
cannot be unperfected. 

4.1 Steps 
1. Select "Yes" from the Request Details page using the Request Perfected drop-down. 
2. Optional – Adjust the date of request perfection using the Perfected Date field. The Perfected 

Date field only displays when “Yes” is selected from the Request Perfected drop-down. The 
Perfected Date can be backdated as far back as the Submitted Date, if needed. If the perfected 
date is backdated, then the clock will start with a non zero number of days. 

 
Exhibit 4-1 Perfecting Request 

3. Press the Save Changes button at the bottom of the Submission Details page. 
4. The clock now displays with a number, counting up from 0, without the text “(Never Started).” 

 
Exhibit 4-2 Clock Has Started 
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*Note: Now that the request is perfected, the clock starts and additional action items are 
available, as shown below in Exhibit 4-3 Unperfected v. Perfected Action item Menu: Stop the 
Clock, Extend Due Date, Upload Responsive Records, Create Consultation, Create Referral, and 
Generate Invoice. The clock displays the number of days since the request was perfected, minus 
any stoppages that were created on the request (5). 

 
Exhibit 4-3 Unperfected v. Perfected Action item Menu 
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4.2 Summary 
Perfecting a request is required to unlock functionality necessary to process the request beyond simple close-
out. If insufficient information is provided, the request can be closed with the proper disposition, or more 
information can be asked of the requester through the Create Correspondence action item (14) without having to 
perfect the request. Once the request is perfected and the clock has started, the agency has 20 working days (30 
if there are unusual circumstances) to close-out the request before it is considered backlogged, indicated by a 
red flag icon displayed next to the clock. The due date may be extended, however, if certain conditions arise (8). 
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5 Estimating Costs 
Send a cost estimate to the requester at any point while the request is open. When a cost estimate is created, the 
system generates an Estimate Cost Notice task for the agency user to review prior to emailing the requester. The 
agency user has the option to mark the estimate for required payment during the close-out of the task. Cost 
estimates that are marked for required payment display to the requester and an agency user is given the ability 
to enter payments through the system. Once the task is closed, the status changes to Estimate Costs. The agency 
user may find this to be an appropriate time to stop the clock for fee-related reasons (see section 6 Stopping the 
Clock). 
5.1 Steps 

1. Click the Estimate Costs action item from the left-side menu of the Request Details page. 
2. Enter appropriate values for the estimate fields. 
3. Optional – Press the Total button to view the total estimate, which includes any applicable fee 

category discounts (see 2.2.1 Request Handling). 
4. Press the Save Changes button to generate the Estimate Costs Notice task. 

 
Exhibit 5-1 Estimate Costs 
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5. Optional – If the total estimate exceeds the requester’s fee limit, then a notification displays. 
Press the Yes button to proceed with generating the Estimate Cost Notice task. 

 
Exhibit 5-2 Fee Limit Notification 

6. Access the Estimate Costs Notice task from one of two locations: the My Cases dashboard of 
the request owner, or the request’s Assigned Tasks tab. 
*Note: If the request is not assigned to an individual, then the task is accessible from the 
Unassigned Cases dashboard of the office the request is assigned. 

 
Exhibit 5-3 Assigned Tasks Tab – Estimate Cost Notice Created 

7. Click the Close Out Task action item from the left-side menu of the Task Details page. 
8. Optional – Select a letter template and modify the text as necessary. This will generate a PDF 

letter that will automatically attach to the email. 
9. Modify the Email Subject and Email Body fields as necessary. 

*Note: The Email Body field automatically populates with the cost estimate provided on the 
Estimate Costs page but can be modified. 

5 



  
 

FOIAonline Agency User Guide                                                                                                                                                                           June 3, 2016 
 25 

10. Select an option from the Mark Estimate as Required? drop-down. 
11. Either press the Send button to send an email to the requester OR, 
12. Press the Close Without Sending button to close the task without sending an email. 

*Note: This is used in scenarios where the requester does not have an email address on file. In 
this case, the agency user should notify the requester of the cost estimate offline. 

 
Exhibit 5-4 Estimate Cost Task Notice – Close-out  

 

 
 
 
 
 
 
 

8 

9 

10 

11 12 



  
 

FOIAonline Agency User Guide                                                                                                                                                                           June 3, 2016 
 26 

13. Upon closing the Estimate Cost task, the request’s Status changes to Estimate Costs. The cost 
estimate is also saved to two places within the case file: Correspondence (2.3.3) and Financing 
(2.3.5). 

 
Exhibit 5-5 Estimate Costs Status 

 

5.2 Summary 
Estimate costs for a request at any point during request processing. The cost estimate factors in any applicable 
requester fee category discounts. A separate task is created in order to view and edit the email sent to the 
requester prior to sending. Once the task is closed, the request’s status changes to Estimate Costs, and the 
correspondence is saved to the Case File – Correspondence page (2.3.3). The cost estimate is also tracked in the 
Case File – Financing page (2.3.5). 

1
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6 Stopping the Clock 
The clock on a request may be stopped for either clarification or fee-related reasons. Doing so will keep the 
clock at its current time until the issue is dealt with and the clock is restarted. A log of all stoppages displays on 
the Stop the Clock page. Requehsts that are on hold display a clock icon next to the tracking number when 
viewing from the dashboard, as shown below, and the Request Details page. 

 
Exhibit 6-1 Stopped Clock Icon 

Guidelines 

 The clock can be stopped for clarification once, but only within the first 20 days.  

 There are no limits on stopping the clock for fee-related reasons. 

6.1 Stop the Clock Steps 
1. Click the Stop The Clock action item from the left-side menu of the Request Details page. 
2. Select an option from the Reason drop-down. 
3. Enter an explanation into the Notes field. 

4. Press the Stop The Clock button. 

 
Exhibit 6-2 Stop the Clock 
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7 Starting the Clock 
After performing the Stop the Clock action (5), the action item in the left-side menu changes to 
Start the Clock. This page logs all clock stoppages that have been performed on the request. 
7.1 Start the Clock Steps 

1. Click the Start The Clock action item from the left-side menu of the Request Details page. 

 
Exhibit 7-1 Start the Clock Action item 

2. Press the Start the Clock button. 

 
Exhibit 7-2 Start the Clock Page 

7.2 Summary 
Once the clock is stopped, it remains at the current number of days until it is restarted. The action item to start 
the clock is found where the stop the clock action item was originally listed. Once restarted, 
the clock may again be stopped using the same method, however, clarification will not be 
available if it has already been used or if 20 days has elapsed. 
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8 Extend Due Date 
By default, the request due date is set 20 working days from the perfected date. If more time is needed, whether 
due to unusual circumstances or not, the due date can be extended to a new date determined by the user. If a 
Public Liaison, Professional, or SME performs the following steps to extend the due date, then the extension 
must be approved by the component’s management. The system automatically generates a task and assigns it to 
the component’s Unassigned Cases dashboard for National Team or Coordinators to approve or deny. 
8.1 Extend Due Date Steps 

1. Click the Extend Due Date action item from the left-side menu of the Request Details page. 
2. Select Yes or No from the Is Extension due to Unusual Circumstances? drop-down. 

*Note: If No is selected, Requester Extension Approval and Date Requester Extension 
Approval Granted required fields display. 

3. Optional – Change the Estimated Date of Completion if necessary. 
4. Enter an explanation into the Extension Justification field. 
5. Press the Extend Due Date button. 

 
Exhibit 8-1 Extend Due Date Page 

6. National Team or Coordinators at this point may need to complete the Extend Due Date Task, 
if one was generated. If no approval is necessary, then the Due Date will automatically update. 

 
Exhibit 8-2 Extend Due Date Task Generation Confirmation 
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7. Once the National Team or Coordinator accesses the task, either select Grant or Deny from the 
Decision drop-down. 

8. Press the Close Out Task button to complete the task. 
*Note: If granted, then the request’s Due Date will update accordingly. 

 
Exhibit 8-3 Extend Due Date – Close-out Task 

8.2 Summary 
If more time is required to process the request, extending the due date allows the date of completion to be set to 
a more reasonable date. However, this will not affect the 20 day clock that determines if the request is 
backlogged. Voluntary extension approval may be received through communication with the requester. This 
correspondence will be captured if communicated with a registered user through the system but can also be 
uploaded to the case file using “Other” Correspondence (13). Once an extension is performed, a task is created 
within the system for a FOIA Coordinator to approve. 
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9 Adding Admin Costs 
Processing time entered on the Admin Cost tab populates the annual report and an invoice when it is generated. 
All costs incurred fulfilling requests should be recorded in this table, ranging from time spent searching for 
records to expenses associated to creating copies of records. The two types of costs are: billable, which are 
charged to the user, and non-billable, which are expenses for the agency but not present on the user invoice. 
Individuals who are tasked from the request (12) also have access to enter their processing time prior to closing 
the task. Time can also be entered for users who do not have a system account. The importance of capturing 
both billable and non-billable expenses results from the inclusion of these costs in the end of the year FOIA 
annual report. 
The system automatically deducts any applicable requester discounts based on the Fee Category selected on the 
Submission Details tab (2.2.1). The total billable cost minus any discounts will be applied to the invoice and 
reflected on the Admin cost page. 

9.1 Adding Billable Time Steps 
1. Click the Admin Cost tab while on the Request Details page. 
2. Press the Add New Entry button to display the New Entry form. 

 
Exhibit 9-1 Admin Cost Tab 

3. Select the appropriate User Type for the cost being entered. 
*Note: Your user populates automatically with an administratively-set billable rate. 

4. Optional – To enter time for another user with a system account, click the person icon to the 
right of the field and search for an individual in the popup. To enter time for another user who 
does not have a system account, select Non-System User from the User Type drop-down and 
enter their Loaded Rate and Billing Rate. 

5. Select the appropriate Charge Type for the cost being entered. 
6. Enter the appropriate expense information based on the Charge Type selected. This will either 

be an hourly or per quantity value. For hourly costs, time can be entered in 15 minute increments 
(15 minutes = 0.25). 

7. Use the Billable? drop-down to indicate if a charge is or is not billable to the requester. 
*Note: A required text field will display to explain non-billable costs. All non-billable costs will 
be charged as an agency cost to process FOIA requests. 

8. Press the Save Changes button. 
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Exhibit 9-2 New Cost Entry   

9. The Total displays the running total of all the billable and non-billable charges entered.  
10. The Invoice Amount displays at the bottom of the Entries table. This is the total billable 

amount minus deductions based on the fee category (2.2.1) selected, and will display on the 
generated invoice (18). 
*Note: View the requester’s fee limit in the expandable/collapsable requester contact 
information section (2.1). 

11. Optional - Click the pencil icon to edit any existing entries. 

12. Optional - Click the remove icon to remove an entry from the list. 

 
Exhibit 9-3 Admin Cost Entries Table   

9.2 Summary 
The information entered under the Admin Cost tab is included on the invoice and, for charges designated 
billable, charged to the requester after close-out. All charges designated non-billable are calculated as expenses 
to the agency to process FOIA requests and are captured for the annual report. Any requester discounts will be 
automatically applied to the invoice generated by the system and are represented by the Invoice Amount on the 
Admin Cost tab. 
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10 Uploading Records 
Request owners and those tasked with Request Details tasks (12) can upload responsive records to the case file 
of a perfected request (4). Records must have a release type associated to them, so it is preferable to upload 
records of the same release type using the Upload Responsive Records page. However, the release type can be 
individually modified on each record after the records are uploaded. 
Files can be added to the case file in two ways: An electronic file can be uploaded, or a file can be referenced 
but not physically attached to the case file. Classified documents should never be uploaded, nor referenced, in 
FOIAonline. Sensitive documents should never be uploaded, but can be referenced using the Add Without File 
Upload functionality. 
In ideal circumstances, high agency network connectivity and low system load, the ability to upload responsive 
records will rarely exceed 100MB at one time. All file types, with the exception of executable (EXE) files, are 
accepted. 
Records marked with the release type of Unredacted – Unreleasable and Redacted – Unreleasable will never be 
available to the requester or to the general public. Records marked as Unredacted – Releasable and Redacted – 
Releasable will be available to both the requester and to the general public. Records marked as Release to 
Requester Only will only be available to the requester, if the requester has a registered user account and is 
logged in, and the general public will not be able to view these records. 
Appeals staff has full access to the associated request, so having a complete case file (redacted and unredacted 
versions of records) provides them the information they need to evaluate the appeal without having to contact 
the original processor. 

10.1 Uploading Responsive Records 
1. Click the Upload Responsive Records action item from the left-side menu of the Request 

Details or Task Details page. 
*Note: The request must be perfected in order to access this action item (see section 4 Perfecting 
a Request). 

Electronic Record 
2. Press the Select Files button to select a file to upload (from your computer). 
3. Select a file(s) from the popup that displays and press Open. 

*Note: Multiple files can be uploaded at the same time using the Ctrl or Shift key on your 
keyboard. 
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Exhibit 10-1 Select File for Upload  

Referenced Record 
4. If no file exists for the responsive record (i.e. the record exists only in hard copy or as media), or 

the record is a sensitive document, press the Add Without File Upload button. 
*Note: This functionality is also useful if the request will be denied in full and your agency has 
chosen not to upload records unless they will be released. 

 
Exhibit 10-2 Add Record Without Upload  

5. All selected files are added to the Upload Responsive Records table. 
*Note: Responsive records uploaded without a file are not hyperlinked on the Case File - 
Records sub-tab (as there is no associated record to display upon clicking). 
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6. Optional – Change the Record Title field if the record name differs from the file name, or if the 
record does not have a physical file attached. 

7. Optional – Press the remove icon to remove a record. 
8. Optional – Press the Cancel button to cancel the upload process. All records on the page will 

not be uploaded to the case file. 
9. Select a Release Type to be applied to the entire batch of records being uploaded. 

*Note: Responsive records will not be available to the general public upon uploading. The 
request must undergo either an interim release or final closeout in order for the appropriate 
records to be released. The Release Type can be individually modified after records are 
uploaded. 

Unredacted – Unreleasable: Will not be available to the general public.  
Unredacted – Releasable to the General Public: Will be available to the general 
public.  
Redacted – Unreleasable: Will not be available to the general public.  
Redacted – Releasable to the General Public: Will be available to the general 
public. 
Release to Requester Only: Will not be available to the general public; will be 
available to the registered requester, upon logging in. 

10. Optional – Enter keywords that can be used to filter responsive records in the agency user’s case 
file, and can also be used by the public (once the records are released) to search for records. 

11. Press the Save Changes button to upload the records to the Case File - Records sub-tab 
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Exhibit 10-3 Save Records  

12. Optional – Modify the drop-down in the Publish column to change the release type. 
*Note: Records are grouped by release type, in the following order: REQ, RR, UR, RU, and UU.  
Releasable records (REQ, RR, and UR) are highlighted. 

13. Press the Save Changes button. 
14. Optional – Edit the records details, including Title and keywords, and apply exemptions by 

clicking the pencil icon to display the Edit Responsive Record page (see Exhibit 11-2). 
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Exhibit 10-4 Verify Uploaded Records  

10.2 Summary 
Uploading records is the main focus in fulfilling a request. Once the records are uploaded, multiple actions can 
be taken, including creating referrals or consultations, adding exemptions, and performing interim releases. As 
task owners upload records via the task, records aggregate to the Case File – Records sub-tab so the complete 
list displays at all times. Task owners are only able to edit or remove records they upload; full edit access to 
records is restricted to the request owner (all records) or the record owner (only records he or she uploads). 
Records identified as “releasable” or “release directly to requester” are only released following either the 
interim release or final close-out processes. 
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11 Apply Exemptions 
After uploading a record (10.1), access it by viewing the Case File – Records sub-tab. From here, multiple 
actions can be performed on a record, including applying exemptions. 
11.1 Steps 

1. While on the Case File – Records sub-tab, click the pencil icon in the Action column to display 
the Edit Responsive Record page. 

2. Select the checkbox(es) of the exemption(s) you would like to apply. 
3. Conditionally Optional –Select a pre-existing statute (multiple can be selected using the Ctrl or 

Shift key) after selecting exemption 3.  
*Note: If no applicable statute exists, then contact your component administrator and request a 
new statute be added to the drop-down. 

4. Conditionally Optional –Select a pre-existing subtype (multiple can be selected using the Ctrl or 
Shift key) after selecting exemption 5. 
*Note: If no applicable subtype exists, then contact your component administrator and request a 
new subtype be added to the drop-down. 

5. Press the Save Record Changes button. 

 
Exhibit 11-1 Edit Record 

11.2 Summary 
Requests containing a record with an exemption cannot be assigned the Full Grant final disposition. Exemptions 
applied to records count towards reporting metrics. If the same exemption is applied to multiple records within 
the same request, that exemption is only counted once towards the annual report. 
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12 Creating Tasks 
There are several different types of tasks within the system, many of which are automatically generated 
by the system upon performing a specific action. Types of tasks include: 

 Fee Waiver – to adjudicate separate from the request 

 Expedited Processing – to adjudicate separate from the request 

 Estimate Costs Notice – to notify the requester of a fee estimate 

 Extend Due Date – to gain approval for an extension 

 Interim Release Initial/Final Review – to notify a reviewer that a request or referral is ready for an 
interim release (Initial Review tasks are generated for all but the final reviewer) 

 Interim Release Notice – to notify the requester of an interim release 

 Initial/Final Review – to notify a reviewer that a request or referral is ready for final close-out (Initial 
Review tasks are generated for all but the final reviewer 

 Final Disposition Notice – to notify the requester of a final disposition 

 Partial Determination Initial/Final Review – to notify a reviewer that an appeal is ready for a partial 
determination (Initial Review tasks are generated for all but the final reviewer) 

 Partial Determination Notice – to notify the requester of a partial determination 

 Request Detail – to collaborate with other individuals or organizations 
The only task type that is manually-generated is the Request Detail task. This is done via the Create Task 
action item in the request’s left-side menu. All tasks, once generated, can be tracked from within the 
Assigned Tasks tab on the Request Details page. The system does not allow you to begin the closeout 
process if there are any pending tasks, so use the Assigned Tasks tab to keep track of any outstanding items. 
Request Detail task assignments are used for agency users to collaborate with other users within the same 
agency. Creating tasks off a request breaks the request down into pieces that may be collaborated upon to 
facilitate processing. 
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12.1 Steps 
1. Click the Create Task action item from the left-side menu of the Request Details page. There are 

two assignment options that allow the user to assign to an office or to an individual. 
2. Press the Add Organization (steps 3-8) button or the Add Individual (steps 9-14) button to 

assign the task to an organization or individual, respectively. 

 
Exhibit 12-1 Task Assignment Page 
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3. Press the Add Organization button to open the Select Organization lookup. 
4. Enter information into the Acronym or Name field. 
5. Press the Search button. 
6. Click a radio button in the first column next to the desired result. Only one organization can be 

selected at a time. 
7. Press the Select button. 
8. To add another organization, repeats steps 3-7. 

 
Exhibit 12-2  Organization Lookup  
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9. Press the Add Individual button to open the Select Individual lookup. 
10. Enter information into any of the following three fields to search for an individual: Name, 

Organization Acronym, and/or Organization Name. 
11. Press the Search button. 
12. Click a radio button in the first column next to the desired result. Only one individual can be 

selected at a time. 
13. Press the Select button. 
14. Optional – If the selected individual has multiple actual agencies, then a popup will display with 

the Available Actual Agencies section. Click the radio button to the left of the desired agency 
and press the Select button. 

15. To add another individual, repeat steps 9-14. 

 
Exhibit 12-3 Individual Lookup 
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16. Optional-Make a selection in the Type of Task dropdown 
17. Enter a description of the task in the Task Description field. 
18. Enter a date in the Task Due Date. 
19. Select Yes or No from the Allow task recipient(s) to edit metadata drop-down. 

Selecting Yes from this drop-down grants the task recipient(s) access to edit the fields on the 
Submission Details tab of the Request Details page (e.g., Request Track, Fee Category, 
Information Publicly Available flags, etc.). 

20. Press the Create New Task button. 
*Note: All tasks have the same tracking number as their associated request. 

 
Exhibit 12-4 Create Task   

12.2 Summary 
Creating a task off a request allows for the request to be sent to other agency users for collaboration. The task 
can be sent to multiple organizations and multiple individuals. The list of all tasks that have been generated on a 
case displays under the Assigned Tasks tab and contains the status, who it is assigned to, and the task due date. 
Task recipients receive an email notification, alerting them of the new item that now exists in either their My 
Cases dashboard (individual assignment) or Unassigned Cases dashboard (the designated FOIA Officer of the 
organizationally assigned task receives this email). Tasks have the same tracking number as their associated 
request. 
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13 Closing Tasks 
If someone has assigned you a task, then you will receive a system email notification. Any task assigned to you 
is accessible via your My Cases dashboard. 
All tasks must be closed prior to beginning the request’s closeout process (19). Request Detail tasks (12.1) grant 
the ability for the task owner to view the entire case file, bill admin time (9), upload responsive records (10), 
comment on the case file (15), and even create additional Request Detail tasks (12), if additional collaboration 
is necessary. Some tasks can also be assigned or re-assigned (2) (e.g., assigning a Fee Waiver task out of the 
Unassigned Cases dashboard or assigning a Request Detail task that was assigned to your organization to an 
individual). 
Every task is closed by clicking the last action item in the left-side menu while on the Task Details page. This 
action item will say either “Edit or Close Out Task” if a comment can be saved on the Close Out Task page, or 
“Close Out Task” if there is no Save button on the Close Out Task page. The following steps outline the process 
to close-out a Request Detail task. 
13.1 Steps 

1. Click the tracking number of the task that exists in the dashboard to display the Task Details 
page. 
*Note: Since tasks have the same tracking number as their associated request, pay careful 
attention to the Type column in the dashboard. Hover over the tracking number to display the 
description of the task. Dashboards can be filtered to display only tasks at one time. Expanding 
out the Detail row displays the type of task the item is. See section 12 for a complete list of Task 
Types. 

 
Exhibit 13-1 Accessing a Task  

2. Optional – Upload responsive records to the case file (10). 
3. Optional – Add a comment to the case file (15). 
4. Optional – Create additional tasks if additional collaboration is necessary (12). 
5. Optional – Add time to the Admin Cost tab (9). 
6. Optional – Assign or re-assign the task (3). 
7. Click either the Close Out Task or Edit or Close Out Task action item from the left-side menu 

of the Task Details page. 
8. Select Records Uploaded, No Records Found or Other from the Outcome drop-down.  
9. Enter a comment in the Comments field. For instance, if the task description was to search for 

responsive records, then indicate the records uploaded, if any, or what locations/databases were 
searched, etc. 

 1 



  
 

FOIAonline Agency User Guide                                                                                                                                                                           June 3, 2016 
 45 

10. Press the Close-out Task button. 
*Note: The task is now closed and is removed from your dashboard. The request owner is 
notified upon task closure, and the appropriate outcome now displays in the Assigned Tasks tab 
of the request. 

 
Exhibit 13-2 Close-out a Request Detail Task  

13.2 Summary 
If someone has individually assigned a request to you, then you will receive a system notification alerting you 
of the assignment. Access the task from the My Cases dashboard and perform any necessary processing. View 
who assigned the task to you by viewing the Task Details. All tasks must be closed prior to beginning the 
closeout process, so be sure to close all tasks assigned to you to allow the request owner the ability to close the 
request.  
System-generated tasks related to a request you are processing will automatically be available in your My Cases 
dashboard (e.g., Interim Release Notice, Final Disposition Notice, etc.) 
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14 Creating Correspondence 
Any communication with the requester is accomplished through the Create Correspondence action item. This 
section captures both system initiated and offline correspondence. If the requester has a registered user account, 
then system correspondence, including replies, can take place entirely within the system. When the requester 
replies within FOIAonline, a mail icon, shown below, displays next to the tracking number on the dashboard. 
Once the unread correspondence is viewed in the Case File – Correspondence tab, the mail icon no longer 
displays. 

 
Exhibit 14-1 New Correspondence Icon 

Form letters can be edited and generated from this page, for both correspondence sent directly to the requester 
and for correspondence being uploaded to the case file. 

14.1 Correspondence Steps 
1. Click the Create Correspondence action item from the left-side menu of the Request Details 

page. 
2. Select Correspondence to Requester (steps 3-7) or Other (steps 8-11) from the 

Correspondence Type drop-down. 

Correspondence to Requester 
*Note: If the requester does not have an email address on file, then text will display, shown 
below, notifying you that the correspondence has no recipient, and therefore cannot be emailed. 
It will still be saved to the case file, however. If you have the requester’s email address and need 
to add it to the case file, do so by editing their contact information (2.1). 

 
Exhibit 14-2 Create Correspondence – No Email Address on File Warning 

3. Optional – Select a letter from the Letter Template drop-down. 
*Note: After selecting a letter template, the Email Body field is replaced with letter- specific text, 
and a new Letter field displays. See 14.2 Letters for more information. 

4. Enter appropriate text in the Email Subject field. 
5. Enter a message in the Email Body field. 

*Note: The Body field pre-populates with basic request information, including the date and time 
and the tracking number. 

6. Use the Insert drop-down to enter request-specific information, e.g., Tracking Number, request 
description, submitted date, etc. 

7. Optional – Press the Select Files to upload correspondence attachments from your computer to 
be sent along with the email to the requester. 

8. Press the Create button. 
*Note: The correspondence has been emailed to the requester if there is an email address on file. 
If the requester has a registered user account, then he or she will be able to reply directly from 
within the system to the correspondence. 
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Exhibit 14-3 Email the Requester  
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Other 
*Note: “Other” correspondence requires either at least one file to be uploaded to the 
Correspondence Attachments section, or that a letter be selected and saved. 

9. Optional – Select a letter from the Letter Template drop-down. 
*Note: After selecting a letter template, the Letter field displays. See 14.2 Letters for more 
information. 

10. Optional - Press the Select Files button and select a file from your hard drive to upload. The 
selected file displays in a table prior to being saved to the case file. 

11. Press the Create button. 

 
Exhibit 14-4 Create Offline Correspondence Page  
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12. View all correspondence sent from the requester, if the requester has a registered account, and to 
the requester from the Case File – Correspondence sub-tab. 
*Note: The Correspondence to Requester section includes automated correspondence, e.g., the 
confirmation email the requester receives upon request submission. 

13. Click the Detail icon to expand the body of the email. If any attachments were sent with the 
request, including a letter, then they also display. 

14. Optional - Click the remove icon to delete the correspondence from the case file. 
*Note: This does not recall the email from the requester’s email inbox. 

 
Exhibit 14-5 Case File – Correspondence Sub-Tab   

14.2 Letters 
Form letters that are added in the Administration Letters page (see the FOIAonline Administration Guide), are 
available to be selected from the Letter Template drop-down on the Create Correspondence page. Selecting a 
letter for “Correspondence to Requester” will send the PDF letter to the requester as an attachment to the email. 

1. Select a template from the Letter Template drop-down to display the Letter field. 
*Note: If this is “Correspondence to Requester,” then the Email Body field will be replaced with 
the letter body text. 

2. The Letter field pre-populates with the following: agency mailing address, requester name, 
organization, mailing address, today’s date, Dear [requester name], letter body, Sincerely, 
request owner, and the request owner’s actual agency. 

 12 
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Modify the text as necessary, including using the Insert drop-down to insert request-specific 
information. 
*Note: Once the correspondence is created, the Letter field is saved as a PDF, and is either 
attached to the email sent to the requester (“Correspondence to Requester”), or is saved to the 
Other Correspondence section (“Other”). View the PDF letter by expanding out the Detail 
column in the Correspondence to Requester section in the Case File – Correspondence sub-tab 
(see Exhibit 14-5 Case File – Correspondence Sub-Tab). 
 

 
Exhibit 14-6 Correspondence – Select a Letter Template    
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14.3 Summary 
Correspondence is captured through the Create Correspondence action item. Capture email and system 
correspondence via the Correspondence to Requester type. The correspondence message, optional formal letter, 
and optional attachments are saved in the case file and are emailed to the requester. If the requester does not 
have an email address assigned to their account, then the correspondence is added to the case file but no email is 
sent. Capture offline correspondence (e.g., telephone conversation) via the Other correspondence type. The 
letter and/or the attachment is included in offline correspondence, which is added to the case file. 
Correspondence is never available to the general public. Only “Correspondence to Requester” items are 
available to the requester, if they have a registered user account. “Other” correspondence is not available to the 
registered requester. 
Automatic correspondence is also saved to the case file, e.g. Submission Confirmation, Estimate Costs Notice, 
Interim Release Notice, and the Final Disposition Notice. 
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15 Creating Comments 
Comments on a case file are visible only by agency users who have access to the request. Create a comment 
through the Create Comment action item in the left-side menu. If any comments were entered at the time of 
assignment (3), they also display in this section. The number of comments that exist displays in the tab, as 
shown below. 

 
Exhibit 15-1 Number of Comments  

15.1 Steps 
1. Click the Create Comment action item from the left-side menu of the Request Details page. 
2. Enter text in the Comment field. 

3. Press the Save button. 

 
Exhibit 15-2 Create a Comment Page 
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4. Click the pencil icon to expand the Edit Comment field. 
*Note: You can only edit comments if you are either the request owner, or a user with a 
management role. System automated comments cannot be modified. 

5. The Comment field pre-populates with the text, but can be modified. 
6. Press the Save Changes button to save the modifications to the comment. 

 
Exhibit 15-3 Edit Comments 

15.2 Summary 
The comments are saved to the case file with a timestamp. Comments can be used for any number of reasons, 
including to indicate external actions that have taken place, e.g. phone calls placed to involved parties, or as a 
timeline for remaining actions required to close a request. Comments can be added via the Create Comment 
action item in the left-side menu or during the assignment process. 
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16 Add Reviewer 
A review of the case file by another individual prior to request closure may be required by your agency or 
office. Even if your office does not require a case file review, it is recommended that one be performed to 
ensure accuracy in the released materials. The request owner may add him or herself to the Assigned Reviewers 
section, but this will not allow you to bypass the minimum reviewer requirement. If your office has a minimum 
reviewer requirement, then that must be fulfilled by adding individual(s) other than yourself. See 19.2 Case File 
Review Steps for more information. 
16.1 Steps 

1. Press the Add Reviewer button from the Request Details-Review tab. 

 
Exhibit 16-1 Review Tab  

 
2. Enter information into any of the following three fields to search for an individual: Name, 

Organization Acronym, or Organization Name. 
*Note: Users may also choose to assign themselves to a review position by pressing the Assign 
To Me button, but at least one reviewer other than the user must be assigned to begin close-out 
when a review is required. 
There is no search restriction on individuals added to the Review tab. 

3. Press the Search button. 

 
Exhibit 16-2 New Reviewer  

 

 
 
 
 
 
 
 
 

 1 

 2 

 3 



  
 

FOIAonline Agency User Guide                                                                                                                                                                           June 3, 2016 
 55 

4. Click a radio button in the first column for the desired result. 
5. Press the Select button. 

 
Exhibit 16-3 Individual Lookup  

6. Optional – When multiple reviewers are assigned, click the Change Review Order icons to 
change the review order positions. 

7. Optional – Press the remove icon to remove a reviewer. 

 
Exhibit 16-4 Multiple Assigned Reviewers  

16.2 Summary 
Reviewers are not notified upon being added to the Review tab as the review chain is being established and no 
action is necessary at this point in time. Once the request close-out process is initiated and the review process 
begins, reviewers receive a notification as with any other task assignment. All assigned reviewers are 
responsible for approving the Case File Review Task when the close-out process is initiated in order to close the 
request. The request owner may be assigned as a reviewer, but at least one other user must review the case file 
if a review is required. 
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17 Interim Release 
An interim release allows for selected records to be released prior to the final disposition of the overall 
request. This can be useful for complex requests that generate several records and close-out of the request 
is dependent on a consultation that is taking longer than expected. See section 9 for how to upload 
responsive records. 

17.1 Steps 
1. Click the Interim Release action item from the left-side menu of the Request Details page. 
2. Optional – Select the Interim Release Notice letter from the Letter Template drop-down. Modify 

the pre-populated formal letter that will be saved to the Other Correspondence section of the 
case file and will be attached as a PDF file to the email sent to the requester upon closing out 
the Interim Release Notice Task. See section 14.2 for more information regarding letters. 

3. Verify the drop-downs in the Publish column. Records marked as UR and RR will be released to 
both the requester and the general public, and records marked as REQ will only be released to 
the requester, if the requester has a registered user account. 
*Note: Records with a grayed out drop-down have been released during a previous interim 
release and cannot be “released again.” 

4. Optional – Enter text in the Invoice Comments/Instructions field. 
*Note: This populates the invoice that is generated (18). 

5. Press the Save Changes button. 
*Note: Upon pressing the Save Changes button, the case file review chain (19.2) will initiate, if 
one is required for your agency. 
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Exhibit 17-1 Interim Release Page   
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6. Once the case file review chain is complete, or if one was not required, the system generates the 
Interim Release Notice task. Access this task by clicking the tracking number from the My 
Cases dashboard, shown below in Exhibit 17-2 Access the Interim Release Notice Task, or via 
the Assigned Tasks tab of the request. 
*Note: The request owner receives an email notification when the Interim Release Notice task is 
generated. 

 
Exhibit 17-2 Access the Interim Release Notice Task  

7. Click the Close Out Task action item item in the left-side menu to display the Close-out Task 
page. 

8. Optional - Modify the Subject field. 
9. Optional - Modify the Body field as necessary. This is the body of the email sent to the requester. 

*Note: Use the Insert drop-down to insert request-specific information. 
10. Optional – Press the Select Files button to attach a file from your computer to be sent with the 

email. 
11. Select an option from the Attach to Send required drop-down to either attach the invoice and 

send the invoice to the requester, or to not attach the invoice to the correspondence and indicate 
the payment is not required.   

12. Optional – Press the Select button for items within the Attach Records or Past Correspondence 

section. This section can be filtered to display only correspondence items, or records marked as 
releasable or release to requester only. 
*Note: Items selected here move to the Selected Items to Be Sent to Requester section. 

13. Press the Send button. 
14. Enter your user account password in the popup and press the OK button. If your agency is 

CAC/PIV-enabled, then you will bypass this step. 
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Exhibit 17-3 Interim Release – Close-out   
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17.2 Summary 
An interim release follows the same series of processes as request closure. If your office has a minimum 
reviewer requirement, then creating the interim release notice sends a task assignment to the first reviewer 
indicated under the Review tab (19.2). Once the review chain is complete, the system generates an Interim 
Release Notice task, which is assigned to the request owner. Once the request owner completes the task, the 
designated records are released and an email notification is sent to the requester. The Interim Release Notice 
email is stored within the Case File – Correspondence tab (14). 
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18 Generating an Invoice 
The request’s invoice is generated using information captured on the Admin Cost tab, and excludes both non-
billable costs and requester-eligible discounts. The invoice is automatically generated by the system and saved 
to the Case File – Financing sub-tab when either an interim release or the final close-out process have begun. 
The request owner can preview the invoice at any time while the request is open in order to view the total cost 
being billed to the requester (total billable charges minus any eligible discounts). Manually generating the 
invoice also saves it to the Case File – Financing sub-tab. 
18.1 Steps 

1. Click the Generate Invoice action item from the left-side menu of the Request Details page. 
*Note: Depending on your browser, you may need to press an Open or OK button in a popup 
that displays. 
Note: The Comments/Instructions text can be populated when completing the first step of 
either the interim release (17) or the final close-out process (19.1). 

2. Only billable charges display in the Description of Costs section. 

 
Exhibit 18-1 Invoice 
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3. View the invoice again via the Case File – Financing tab. 
4. View the Total Amount Billed Which Has Been Sent To Requester within the invoice section. 

This value is represented by the most recent invoice amount sent.  
5. Optional - Select an option from the Sent drop-down menu to either mark the invoice as sent to 

the requester or as not sent. Press the Save Invoice Changes button to save any modifications. 
6. Optional - Click the remove icon to delete the invoice from the case file. 

 
Exhibit 18-2 Case File Financing Tab - Invoice 

18.2 Summary 
The invoice offers a snapshot of the billable cost information as well as all important request details. This is 
automatically saved to the Case File – Financing sub-tab when manually generated via the action item menu 
and when initiating the interim release and/or final close-out processes. Invoices can be deleted from the case 
file as desired. 

 3 

4 

 5 
 6 

 5 



  
 

FOIAonline Agency User Guide                                                                                                                                                                           June 3, 2016 
 63 

19 Close a Request 
There are two criteria every request must meet prior to beginning the close-out process: 1. The request must be 
assigned to an individual (3) and 2. Any tasks that exist in the Assigned Tasks tab must be closed (12). 
Additionally, if your office has a minimum reviewer requirement, then the proper number of reviewers, not 
including yourself, must be added to the Review tab (16). If your office does not have a reviewer requirement, 
then it is still encouraged to add an individual to the Review tab to provide a final chance to review the case file 
prior to releasing information to the public.  
The Closeout process is a multi-step process, either 2 or 3 mandatory steps depending on your component’s 
“minimum reviewer” requirement. Step 1 is to assign a disposition (19.1), step 2 is to complete the case file 
review (19.2), and step 3 is to complete the Final Disposition Notice task (19.3). 

19.1 Assign a Disposition Steps 
1. Click the Begin Close Out action item from the left-side menu of the Request Details page. 
2. Select a disposition from the Disposition drop-down. 

*Note: If no applicable disposition exists in the standard list of dispositions, then select Other 
from the drop-down to view the Other Disposition drop-down. If still no applicable disposition 
exists, then contact your component administrator and request a new “Other” disposition be 
added to the drop-down. 

3. Optional – select the Final Disposition Notice letter from the Letter Template drop-down to 
display the editable Letter field. This is pre-populated with request and agency-specific 
information, and the disposition dynamically updates based on the selection made in the 
previous field. 

4. If records are uploaded, verify the drop-down in the Publish column to ensure the correct records 
are being released, if applicable. 

5. Optional: Enter text in the Comments/Instructions field, which will populate the system 
generated invoice (18). 

6. Press the Begin Close-out button. 
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Exhibit 19-1 Final Disposition Page  
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7. Click the Yes button in the popup. 

 
Exhibit 19-2 Begin Close-out Process  

Note: The status changes to Final Preparation of Response and depending on your role, the 
left-side action menu may significantly decrease. Once the close-out process has begun, no 
processing is permitted. Step 1 of the close-out process is complete and the system automatically 
initiates step 2, the Case File Review, if applicable. 

19.2 Case File Review Steps 
Upon completing the first step of the close-out process, the system generates an Initial Review task for the first 
reviewer, if applicable. This reviewer receives both a system email notification and a task in their My Cases 
dashboard. The request owner can track the progress by viewing the Review tab or the Assigned Tasks tab, as 
the status of the review is contained in both locations. This task grants the reviewer a read-only view of the 
entire case file. After the reviewer inspects the final disposition that was assigned, any responsive records, and 
any other metadata within the request, the reviewer can choose to either Approve or Deny the review task. 
Denying the review task lifts the processing restrictions that were implemented upon beginning the close-out 
process. The request owner can view comments provided with the case file rejection via the Assigned Tasks tab, 
make the necessary modifications, and initiate the close-out process again. Initial Review tasks will be sent to 
each reviewer in succession until all reviewers have approved their task, and conclude with the last reviewer 
who is assigned the Final Review task. 
The role of the user assigned to review a case file before close-out is to navigate the case file and examine the 
metadata and records for release. If the reviewer approves of the disposition set by the processor, they can close-
out the task for it to be sent to the next reviewer or back to the processor for final close-out. 

1. Click the Tracking Number link for the Case File Review task. The Case File Review task can 
be identified by expanding the Details column or by hovering over the Tracking Number link. 

 
Exhibit 19-3 Expanded Task Details 

 

1 

7 



  
 

FOIAonline Agency User Guide                                                                                                                                                                           June 3, 2016 
 66 

2. Review the request to ensure an appropriate disposition, charges, record release type, etc. have 
been applied to the case file (see section 2 Navigating the Request Details Page). 

3. Click the Edit or Close Out Task link in the left-side menu. 

 
Exhibit 19-3 Review Task Details  
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4.   Optional – Enter text in the Comments field. 
5.   If you wish to save any text entered in the Comments field and return to the task to complete at a 

later time, press the Save button. 
6.   Press the Approve button if you wish to approve the task as it is and initiate the next step in the 

close-out process, either sending the next reviewer a case file review task or sending the Final 
Disposition Notice Task to the request owner. 

7.  Press the Reject button if you wish to halt the review process and require the request owner to 
make any modifications. Even minor corrections necessitate a user press the Reject button. 
*Note: A Review task that is rejected requires input to the Comments field explaining the rejection. 

 
Exhibit 19-4 Case File Review Comments 

19.2.1 Summary 
Approving an Initial Review sends the task to the next reviewer until the last reviewer, who receives the Final 
Review task. Approval of this task generates the Final Disposition Notice task for the request owner. This 
moves the request to its final processing step before officially closing the request. If information in the case file 
is deemed not ready for approval, it is rejected and the request owner is notified to modify the case file as 
appropriate. The request owner can always track the progress of the case file review by viewing the Review tab 
and the Assigned Tasks tab of the request. 

19.3 Final Disposition Notice Task Steps 
This is the final step in the request close-out process. When the case file review chain is completed, the system 
generates the Final Disposition Notice task and sends the request owner an email notification. When the Final 
Disposition Notice task is closed, all records marked for release and information included in the notice will be 
sent to the original requester's email address. The request will be removed from your dashboard as no closed 
items exist in the dashboards. Re-access the request by either searching or using the Custom Report. 
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1. Click the Tracking Number link for the Final Disposition Notice task. The Final Disposition 
Notice task can be identified by expanding the Details column or hovering over the Tracking 
Number link. 

 
Exhibit 19-5 Final Disposition Notice Task  

2. Click the Close Out Task action item in the left-side menu. 

3. Optional: Depending on your role (Public Liaison, Coordinator, or National Team) you will be 
able to backdate the request’s closure date and close the task without sending an email. This 
ability will display in a section called Offline Closure Date. Select a date and press the Close 

Without Sending button. 
4. Optional – Make changes to the Subject field as necessary. 
5. Optional – Make changes to the Body field as necessary. 
6. Optional – Upload supporting files to be attached to the email using the Select File button as 

necessary. 
7. Select an option from the Attach to Send? required drop-down to either attach and send the 

invoice to the requester or to not attach the invoice, indicating the payment is not required. 
8. Optional – Press the Select button for items within the Attach Records or Past Correspondence 

section. This section can be filtered to display only correspondence items or records marked as 
releasable or release to requester only. 
*Note: Items selected here move to the Selected Items to Be Sent to Requester section. 

9. Press the Send button. 
10. Enter your user account password in the popup and press the OK button.  

*Note: If your agency is CAC/PIV-enabled, then you will bypass this step. 
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Exhibit 19-6 Complete the Final Disposition Notice Task  

19.4 Summary 
With the verification of the confirmation message, the request is closed out. If the request includes the 
requester’s email address, then they will receive an email indicating the final disposition of their request and 
any records that were released with it. The request is removed from your dashboard but it may be viewed again 
by either using the Search function or the Custom Report (20-21). 
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20 Using the Search Function 
The Search function can be used to find all case files types in a variety of statuses both in your own agency and 
outside of your heirarchy. The Search function indexes all items within FOIAonline with full-text capabilities, 
so there is a two hour delay with its results. This means that a request recently created in the system may not 
display in the search results, or a recent status change may not reflect correctly on the results page. This does 
not mean that the status is incorrect. Also, due to the full-text indexing, the Search function can be used to find 
records based on the infromation contained therein. 

Search Tips:  

 Use Boolean search commands to find a more narrowed set of results, e.g. Superfund AND 
wilson. 

 Use wildcards to find a more generalized set of results, e.g. Ex. EPA-2015* 

20.1 Steps 
1. Use either the quick search (to the right of the main set of page tabs) or click the Search tab to 

display the Search page and use the Search For field. 
2. Optional: The Agency field defaults to search for items contained within your level/office of the 

agency and below. Expand your search results by selecting the Other Agencies radio button to 
search for items that exist outside of your immediate agency hierarchy. 

3. Press the Search button. 

 
Exhibit 20-1 Search Criteria 
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4. Click the Detail icon to expand more information. The criteria contained within the item that 
matches the Search For field is highlighted. 

5. Records are full text searchable. Click the paper clip icon to open or save the record file. 

 
Exhibit 20-2 Search Results  

20.2 Summary 
The Search function can be used to quickly find specific items within FOIAonline. Indexing case files and 
records with full-text capabilities allows users to search for information contained within such items. If more 
stringent search criteria is required to find the desired items, then use the Custom Report (21). 
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21 Custom Report 
In addition to the Search function, the Custom Report, which returns results in real-time, can also be used to 
find items within FOIAonline. The Custom Report has a wide variety of search criteria, which allows you to 
perform searches from the general to the highly specific. Refer to section 21.1 21.3 for specific use cases. 

 
Exhibit 21-1 Custom Report 
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21.1 Finding Closed Items 
1. Click the Custom Report link from the left-side menu while on the Reports tab. 
2. Enter a Closed Date range. 
3. Optional: Use the Type criteria to designate the type of case file. 
4. Press the Search button. 

  

Exhibit 21-2 Custom Report Results-Closed Items 
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21.2 Finding Items by Disposition 
1. Click the Custom Report link from the left-side menu while on the Reports tab. 
2. Make (a) selection(s) from either the Request Disposition or Appeal Disposition multi-selects. 

*Note- If a selection is made from the Request Disposition multiselect, then the Request and 
Referral checkboxes in the Type criteria are automoatically checked while the Appeal and 
Consultation checkboxes become read-only. If a selection is made from the Appeal 
Disposition multiselect, then the Appeal checkbox is automoatically checked while the 
Request, Referral, and Consultation checkboxes become read-only. 

3. Optional: Check the Task checkbox in the Type criteria to find tasks also associated to the 
selected disposition. 

4. Optional: Make a selection in the Open? dropdown to search for items that are open or closed 
at the time of the search. 

5. Press the Search button. 

 
Exhibit 21-3 Custom Report Results-Items Associated to a Specific Appeal Disposition 
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21.3 Finding Items Assigned to an Individual 
1. Click the Custom Report link from the left-side menu while on the Reports tab. 
2. Click the person icon to the right of the Assigned to Individual field to launch the Select 

Individual popup. 
3. Enter infromation into any of the three search fields: Name, Organization Acronym and/or 

Organization Name. 
4. Use the radio button to the left of the Full Name column to select the desired user. 
5. Press the Select button. 
6. Press the Search button. 

 
Exhibit 21-4 Custom Report Results-Items Assigned to an Individual 

21.4 Custom Report Export 
The Custom Report results can be exported to a spreadsheet using the CSV or Excel links at the bottom of the 
page. In addition to the fields displayed in the Custom Report table, the export contains the below fields, which 
can be useful for comparing and analyzing data. 

 Requester Organization – organization the requester is affiliated with if applicable 

 Case File Assigned To – individual or office the underlying case file is assigned to when line 
item is a task 

 Perfected? – whether or not a request has been perfected or an appeal has been marked as received 

 Closed Date – date a case file or task completes the close out process 

 Disposition – request and appeal dispositions that have been set prior and after case file closure 

 Additional Information Fields – agency specific fields found in the configurable Additional 
Information section 
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22 My Account 
Agency users can update their contact information, email notification preferences, and change their password 
from the My Account page. 
22.1 Edit Account 
The Edit Account page contains two sections: User Information and Email Preferences. The User Information 
section contains contact information and the email address used for logging in. 
*Note: If your agency is CAC/PIV-enabled, then you will not be able to edit your email address, since the email 
address is linked to the CAC/PIV card. 
The Email Preferences section contains three groups of email notifications. If the toggle is checked, then email 
notifications are active. If the toggle is not checked, then email notifications are inactive. New system users 
default to receiving all notifications. The following notifications are exempt from opt-out: appeal creation, 
requester request modification, withdrawn requests, exported requests, 5 day notifications, and emails regarding 
account notification. 

1. Modify the User Information fields as necessary. 

2. The Clock Auto-Start toggle controls the email notification that is sent when an unperfected 
request’s clock automatically starts after the 10th day of it remaining unassigned. 

3. The Case File Modification Alerts toggle controls the following email notifications: individual 
assignment, organizational assignment (if you are the organization’s designated FOIA Officer), 
items re-assigned from your queue, stopping and starting the clock, and due date extensions. 

4. The Case File Items Completed Alerts toggle controls the following email notifications: 
request detail and review task completions. 

5. Press the Save Changes button to apply changes. 

 
Exhibit 22-1 Edit Account Page  
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22.2 Change Password 
Passwords expire every 60 days. After a password has expired, the user is prompted to change their password 
upon logging in, but the password can also be updated at any time from the My Account tab. You cannot use 
any of your previous 24 passwords. 

1. Modify the User Information fields as necessary. 

2. The Clock Auto-Start toggle controls the email notification that is sent when an unperfected 
request’s clock automatically starts after the 10th day of it remaining unassigned. 

3. The Case File Modification Alerts toggle controls the following email notifications: individual 
assignment, organizational assignment (if you are the organization’s designated FOIA Officer), 
items re-assigned from your queue, stopping and starting the clock, and due date extensions. 

4. The Case File Items Completed Alerts toggle controls the following email notifications: 
request detail and review task completions. 

 
Exhibit 22-2 Change Password 
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FOIA Request NARA-NGC-2022-000165 Submitted System 11/05/2021

This message is to confirm your request submission to the FOIAonline application: View Request . Request
information is as follows: Tracking Number: NARA-NGC-2022-000165 Requester Name: Mr. robert hammond Date
Submitted: 11/05/2021 Request Status: Submitted Description: FOIA Request NARA 22-M Expedited Processing NARA-
NGC-2022-000028. See PDF. I am respectfully seeking: 1. Records from 7 October 2021 to 15 October 2021 related to
the NARA decision to deny expedited processing for this subject case, FOIAonline NARA-NGC-2022-000028. Records
would include, but not be limited to: a. Unredacted emails and other correspondence within the NARA FOIA Office. b.
Unredacted emails and other correspondence within the NARA Media or Public Affairs Office or similar office by any
other name. c. Unredacted emails and other correspondence between the NARA FOAI Office with any other office,
including NARA’s Media or Public Affairs Office or similar office by any other name. d. Records of reviews conducted of
the subject matter of the request for expedited processing and the dedision to deny expedited processing 2. I am also
seeking a copy of this FOIA Request, which is an Agency record subject to FOIA that exists and is in the Agency’s
possession at the time of my FOIA request. This record is a responsive record integral to my Request. Release of the
Agency’s copy is not optional. REQUESTED FORMAT. I am also seeking records in their native format (MS. Outlook,
PowerPoint, Excel, ADA accessible PDF files by return email with: (1) a signed and dated cover letter (citing my
personally assigned requester control number); (2) with record page count for all records released records (3) a copy
of this request in your reply. I seek records via email in PDF format with an imbedded copy of my requests to (1)
impede the agency from not addressing the FOIA Request; (2) impede the Agency from not providing the documents
stated in the Agency’s letter reply, and (3) make it obvious in any subsequent review what the Agency has or has not
done. Further, I request that these records be sent in any digital formats in which they exist (such as PDF and Excel).
Under the terms of the E-FOIA Amendments of 1996, Section 5, if a document exists in electronic format, it must be
released in that format upon request. Each record must be provided as a distinct record in their native format. Emails
should be provided as MS Outlook files, if not encrypted or otherwise unable to be open ed by me. Only if this is not
possible, emails should be produced with their embedded hyperlinked attachments by using the “File => Save as
Adobe PDF” command within Outlook or by other software that produces the same result. I am also seeking the
“Description Available to the Public” field I FOIAonline be set to yes and that all records be released to and viewable in
the application by the general Public. The release type must be set to “Unredacted – Releasable to the General Public:
Will be available to the general public,” or to “Redacted – Releasable to the General Public: Will be available to the
general public.” This request is distinctly separate from any other. Please do not combine this request with any other
request in your reply. I am requesting that each element of the records sought be specifically addressed in the reply.
FEE WAIVER/ PUBLIC INTEREST/PUBLIC RELEASE. Notwithstanding my agreement to pay fees below if my fee waiver
is denied, I am seeking a fee waiver due to significant public interest in this information. The subject of the requested
records concerns "the operations or activities of the government.” The disclosure is "likely to contribute" to an
understanding of government operations or activities. There is no commercial interest. There is significant public
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interest. AGREEMENT TO PAY FEES. I agree to pay fees for searching or copying the records up to $25. If the fees
exceed this amount please advise me of the cost before proceeding. I do not believe that there should be any charge
for providing these records, as there is public interest in government operations. I am a private individual not seeking
documents for commercial use, such that the following applies: “No fees may be charged by any DoD Component if
the costs of routine collection and processing of the fee are likely to equal or exceed the amount of the fee. With the
exception of requesters seeking documents for a commercial use, Components shall provide the first two hours of
search time, and the first one hundred pages of duplication without charge.” I would note that because I am
requesting an electronic file, there should not be a per page copy fee. The OMB Guidelines direct that searches for
responsive records should be done in the "most efficient and least expensive manner." See OMB Fee Guidelines, 52
Fed. Reg. at 10,017. As an “all others” requester, I may only be assessed search and duplication fees and not fees for
review. See 32 CFR 286.12 - Schedule of fees. Also, please note that, should payment become necessary, the Coinage
Act of 1965, specifically Section 31 U.S.C. 5103, entitled "Legal tender," states: " United States coins and currency
(including Federal reserve notes and circulating notes of Federal reserve banks and national banks) are legal tender
for all debts, public charges, taxes, and dues. Foreign gold or silver coins are not legal tender for debts. ( Pub. L. 97–
258, Sept. 13, 1982, 96 Stat. 980 ; Pub. L. 97–452, §1(19), Jan. 12, 1983, 96 Stat. 2477 .) EXPEDITED PROCESSING. I am
seeking expedited processing. The subject is of widespread and exceptional media interest and the information
sought involves possible questions about the government's integrity that affect public confidence. This matter relates
to matters before the FOIA Advisory Committee reporting to the Archivist of the United States, including the
inadequacy of OGIS budgets, OGIS Public Comments Posing Policy, the Mandatory Right to OGIS Dispute Resolution
and others. Open meetings are viewed by thousands, including via permanently preserved You Tube videos. The is
extensive public and media interest. Additionally, I am an individual/organization primarily engaged in the
dissemination of information who can prove the information is urgently needed to inform the public concerning some
actual or alleged government activity. My primary activity is informing the public, which I do through a variety of
means, such as open meeting public comments, blogs, etc., and I may from time to time collaborate on articles. There
is extraordinary, off the charts interest in the subject matter of this meeting and NARA’s execution. DOD POLICY –
PUBLIC TRUST. Reference (c) states, “DoD personnel are expected to comply with the FOIA, this Regulation, and DoD
FOIA policy in both letter and spirit. This strict adherence is necessary to provide uniformity in the implementation of
the DoD FOIA Program and to create conditions that will promote public trust.” STILL-INTERESTED PREEMPTIVE
REPLY. This is a preemptive reply to the Justice Department guidelines the procedure known as a “still interested”
inquiry, through which a FOIA officer can confirm that the requester has not lost interest in obtaining the documents.
My interest in all FOIA requests submitted to your office is enduring, meaning that my interest in seeking replies to all
past and future FOIA request remains in effect until each request has been answered fully and the time for judicial
review has passed. Please do not initiate any "still interested" inquiries. This serves as my notice of enduring interest
and automatic reply to any future questions of interest by your office. There are no reasonable grounds to ever
conclude in the future that I am not interested in this request. Implementation Checklist for DOJ OIP Guidance on
“Still-Interested” Inquiries 1. Ensure there are reasonable grounds to make a “still-interested” inquiry in first instance.
2. Absent good cause, do not make multiple “still-interested” inquiries. 3. Use requester’s preferred method of
communication and in the absence of a preference, communicate by telephone or email as the default. 4.
Memorialize any decision by a requester to withdraw a request that is conveyed by telephone by sending the
requester a brief email or letter noting the withdrawal. 5. Provide requesters no less than thirty (30) working days to
respond to the “still-interested” inquiry and ensure that there is a simple way to do so. 6. Advise the requester that if
they elect not to respond to the inquiry, the request will be administratively closed at the conclusion of the
designated time period (which must be at least 30 working days). 7. Prior to administratively closing a request based
upon the lack of a response by the requester, make good faith efforts to reach out to the requester using multiple
methods of communication. 8. In the event a requester responds to the “still- interested” inquiry within a reasonable
time after the deadline has passed, reopen the request and place it back into the processing queue where it would
have been. PRESERVE RECORDS AND SEARCHES FOR JUDICIAL REVIEW. Please search for, locate and preserve all
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responsive or potentially responsive records and records of your searches in your FOIA case file until the statutory
date for judicial review has passed (should that be necessary) or in accordance with a NARA approved records
schedule, if longer. NARA GRS 4.2 requires that FOIA and Privacy Act case files be retained for 6 years after final agency
action or 3 years after final adjudication by the courts, whichever is later. Records of responsive searches would
include but not be limited to: searches conducted for each specific record sought and all other records known to the
Agency, including dates, manner of searching, responsible agent or employee conducting each search and the results
thereof. Such persons determining the locations of responsive records must be inclusive of persons who would know
such locations and their identities and manner of determining search locations must be preserved. In any subsequent
proceedings, I may seek sworn declarations and a court order appointing a special counsel, as appropriate. ...

FOIA Expedited Processing Disposition Reached for NARA-NGC-2022-000165 System 11/15/2021

Your request for Expedited Processing for the FOIA request NARA-NGC-2022-000165 has been denied. Additional
details for this request are as follows: Request Created on: 11/05/2021 Request Description: FOIA Request NARA 22-M
Expedited Processing NARA-NGC-2022-000028. See PDF. I am respectfully seeking: 1. Records from 7 October 2021 to
15 October 2021 related to the NARA decision to deny expedited processing for this subject case, FOIAonline NARA-
NGC-2022-000028. Records would include, but not be limited to: a. Unredacted emails and other correspondence
within the NARA FOIA Office. b. Unredacted emails and other correspondence within the NARA Media or Public Affairs
Office or similar office by any other name. c. Unredacted emails and other correspondence between the NARA FOAI
Office with any other office, including NARA’s Media or Public Affairs Office or similar office by any other name. d.
Records of reviews conducted of the subject matter of the request for expedited processing and the dedision to deny
expedited processing 2. I am also seeking a copy of this FOIA Request, which is an Agency record subject to FOIA that
exists and is in the Agency’s possession at the time of my FOIA request. This record is a responsive record integral to
my Request. Release of the Agency’s copy is not optional. REQUESTED FORMAT. I am also seeking records in their
native format (MS. Outlook, PowerPoint, Excel, ADA accessible PDF files by return email with: (1) a signed and dated
cover letter (citing my personally assigned requester control number); (2) with record page count for all records
released records (3) a copy of this request in your reply. I seek records via email in PDF format with an imbedded copy
of my requests to (1) impede the agency from not addressing the FOIA Request; (2) impede the Agency from not
providing the documents stated in the Agency’s letter reply, and (3) make it obvious in any subsequent review what
the Agency has or has not done. Further, I request that these records be sent in any digital formats in which they exist
(such as PDF and Excel). Under the terms of the E-FOIA Amendments of 1996, Section 5, if a document exists in
electronic format, it must be released in that format upon request. Each record must be provided as a distinct record
in their native format. Emails should be provided as MS Outlook files, if not encrypted or otherwise unable to be open
ed by me. Only if this is not possible, emails should be produced with their embedded hyperlinked attachments by
using the “File => Save as Adobe PDF” command within Outlook or by other software that produces the same result. I
am also seeking the “Description Available to the Public” field I FOIAonline be set to yes and that all records be
released to and viewable in the application by the general Public. The release type must be set to “Unredacted –
Releasable to the General Public: Will be available to the general public,” or to “Redacted – Releasable to the General
Public: Will be available to the general public.” This request is distinctly separate from any other. Please do not
combine this request with any other request in your reply. I am requesting that each element of the records sought be
specifically addressed in the reply. FEE WAIVER/ PUBLIC INTEREST/PUBLIC RELEASE. Notwithstanding my agreement
to pay fees below if my fee waiver is denied, I am seeking a fee waiver due to significant public interest in this
information. The subject of the requested records concerns "the operations or activities of the government.” The
disclosure is "likely to contribute" to an understanding of government operations or activities. There is no commercial
interest. There is significant public interest. AGREEMENT TO PAY FEES. I agree to pay fees for searching or copying the
records up to $25. If the fees exceed this amount please advise me of the cost before proceeding. I do not believe that
there should be any charge for providing these records, as there is public interest in government operations. I am a
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private individual not seeking documents for commercial use, such that the following applies: “No fees may be
charged by any DoD Component if the costs of routine collection and processing of the fee are likely to equal or
exceed the amount of the fee. With the exception of requesters seeking documents for a commercial use,
Components shall provide the first two hours of search time, and the first one hundred pages of duplication without
charge.” I would note that because I am requesting an electronic file, there should not be a per page copy fee. The
OMB Guidelines direct that searches for responsive records should be done in the "most efficient and least expensive
manner." See OMB Fee Guidelines, 52 Fed. Reg. at 10,017. As an “all others” requester, I may only be assessed search
and duplication fees and not fees for review. See 32 CFR 286.12 - Schedule of fees. Also, please note that, should
payment become necessary, the Coinage Act of 1965, specifically Section 31 U.S.C. 5103, entitled "Legal tender,"
states: " United States coins and currency (including Federal reserve notes and circulating notes of Federal reserve
banks and national banks) are legal tender for all debts, public charges, taxes, and dues. Foreign gold or silver coins
are not legal tender for debts. ( Pub. L. 97–258, Sept. 13, 1982, 96 Stat. 980 ; Pub. L. 97–452, §1(19), Jan. 12, 1983, 96
Stat. 2477 .) EXPEDITED PROCESSING. I am seeking expedited processing. The subject is of widespread and
exceptional media interest and the information sought involves possible questions about the government's integrity
that affect public confidence. This matter relates to matters before the FOIA Advisory Committee reporting to the
Archivist of the United States, including the inadequacy of OGIS budgets, OGIS Public Comments Posing Policy, the
Mandatory Right to OGIS Dispute Resolution and others. Open meetings are viewed by thousands, including via
permanently preserved You Tube videos. The is extensive public and media interest. Additionally, I am an
individual/organization primarily engaged in the dissemination of information who can prove the information is
urgently needed to inform the public concerning some actual or alleged government activity. My primary activity is
informing the public, which I do through a variety of means, such as open meeting public comments, blogs, etc., and I
may from time to time collaborate on articles. There is extraordinary, off the charts interest in the subject matter of
this meeting and NARA’s execution. DOD POLICY – PUBLIC TRUST. Reference (c) states, “DoD personnel are expected
to comply with the FOIA, this Regulation, and DoD FOIA policy in both letter and spirit. This strict adherence is
necessary to provide uniformity in the implementation of the DoD FOIA Program and to create conditions that will
promote public trust.” STILL-INTERESTED PREEMPTIVE REPLY. This is a preemptive reply to the Justice Department
guidelines the procedure known as a “still interested” inquiry, through which a FOIA officer can confirm that the
requester has not lost interest in obtaining the documents. My interest in all FOIA requests submitted to your office is
enduring, meaning that my interest in seeking replies to all past and future FOIA request remains in effect until each
request has been answered fully and the time for judicial review has passed. Please do not initiate any "still
interested" inquiries. This serves as my notice of enduring interest and automatic reply to any future questions of
interest by your office. There are no reasonable grounds to ever conclude in the future that I am not interested in this
request. Implementation Checklist for DOJ OIP Guidance on “Still-Interested” Inquiries 1. Ensure there are reasonable
grounds to make a “still-interested” inquiry in first instance. 2. Absent good cause, do not make multiple “still-
interested” inquiries. 3. Use requester’s preferred method of communication and in the absence of a preference,
communicate by telephone or email as the default. 4. Memorialize any decision by a requester to withdraw a request
that is conveyed by telephone by sending the requester a brief email or letter noting the withdrawal. 5. Provide
requesters no less than thirty (30) working days to respond to the “still-interested” inquiry and ensure that there is a
simple way to do so. 6. Advise the requester that if they elect not to respond to the inquiry, the request will be
administratively closed at the conclusion of the designated time period (which must be at least 30 working days). 7.
Prior to administratively closing a request based upon the lack of a response by the requester, make good faith efforts
to reach out to the requester using multiple methods of communication. 8. In the event a requester responds to the
“still- interested” inquiry within a reasonable time after the deadline has passed, reopen the request and place it back
into the processing queue where it would have been. PRESERVE RECORDS AND SEARCHES FOR JUDICIAL REVIEW.
Please search for, locate and preserve all responsive or potentially responsive records and records of your searches in
your FOIA case file until the statutory date for judicial review has passed (should that be necessary) or in accordance
with a NARA approved records schedule, if longer. NARA GRS 4.2 requires that FOIA and Privacy Act case files be
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retained for 6 years after final agency action or 3 years after final adjudication by the courts, whichever is later.
Records of responsive searches would include but not be limited to: searches conducted for each specific record
sought and all other records known to the Agency, including dates, manner of searching, responsible agent or
employee conducting each search and the results thereof. Such persons determining the locations of responsive
records must be inclusive of persons who would know such locations and their identities and manner of determining
search locations must be preserved. In any subsequent proceedings, I may seek sworn declarations and a court order
appointing a special counsel, as appropriate. ... Expedited Processing Original Justification: EXPEDITED PROCESSING.
I am seeking expedited processing. The subject is of widespread and exceptional media interest and the information
sought involves possible questions about the government's integrity that affect public confidence. This matter relates
to matters before the FOIA Advisory Committee reporting to the Archivist of the United States, including the
inadequacy of OGIS budgets, OGIS Public Comments Posing Policy, the Mandatory Right to OGIS Dispute Resolution
and others. Open meetings are viewed by thousands, including via permanently preserved You Tube videos. The is
extensive public and media interest. Additionally, I am an individual/organization primarily engaged in the
dissemination of information who can prove the information is urgently needed to inform the public concerning some
actual or alleged government activity. My primary activity is informing the public, which I do through a variety of
means, such as open meeting public comments, blogs, etc., and I may from time to time collaborate on articles. There
is extraordinary, off the charts interest in the subject matter of this meeting and NARA’s execution. Expedited
Processing Disposition Reason: The requester has not provided sufficient information to establish he meets one of the
criteria required under the National Archives and Records Administration (NARA) regulation 36 C.F.R. 1250.28 (a) to
justify expedited processing. Specifically, you have not provided evidence that there is an urgent need to inform the
public of a government activity, or widespread and exceptional media interest involving questions affecting public
confidence in the Government’s integrity that can be addressed by the records you seek. If you are not satisfied with
our action on your request for expedited processing, you have the right to file an administrative appeal in writing by
mail or email. If by mail, please address your appeal to the Deputy Archivist (ND), National Archives and Records
Administration, 8601 Adelphi Rd., College Park, Maryland 20740. Both the letter and the envelope should be clearly
marked “Freedom of Information Act Appeal.” If by email, please submit your appeal to FOIA@nara.gov addressed to
the Deputy Archivist. Your appeal should be received within 90 calendar days of the date of this denial, and it should
explain why you think this response does not meet the requirements of the FOIA. If you would like to discuss our
response before filing an appeal to attempt to resolve your dispute without going through the appeals process, you
may contact our FOIA Public Liaison Gary M. Stern for assistance via email at garym.stern@nara.gov . You may also
contact the Office of Government Information Services (OGIS), the Federal FOIA Ombudsman’s office, which offers
mediation services to help resolve disputes between FOIA requesters and Federal agencies. The contact information
for OGIS is noted below: Office of Government Information Services National Archives and Records Administration
8601 Adelphi Road–OGIS College Park, MD 20740-6001 Email: ogis@nara.gov Website: ogis.archives.gov Tel: 202-741-
5770 or 1-877-684-6448

Final Disposition, Request NARA-NGC-2022-000165 Jodi Foor 12/01/2021

NARA-NGC-2022-000165 has been processed with the following final disposition: Full Grant. Given the nature of this
request, some records are only being released to you as the requester. If you have an account in FOIAonline, you may
access those records by [FOIAONLINE_HOME] . Otherwise, those responsive records will be sent via the method
agreed upon with the FOIA processor.

Final Disposition Notice 2021-12-01 063020 Letter.pdf

2021.pdf

NARA 22-M Expedited Processing NARA-NGC-2022-000028 NGC22-101.pdf

Reply
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FOIA Fee Waiver Disposition Reached for NARA-NGC-2022-000165 System 12/01/2021

Your request for Fee Waiver for the FOIA request NARA-NGC-2022-000165 has been determined to be not applicable as
the request is not billable. Additional details for this request are as follows: Request Created on: 11/05/2021 Request
Description: FOIA Request NARA 22-M Expedited Processing NARA-NGC-2022-000028. See PDF. I am respectfully
seeking: 1. Records from 7 October 2021 to 15 October 2021 related to the NARA decision to deny expedited
processing for this subject case, FOIAonline NARA-NGC-2022-000028. Records would include, but not be limited to: a.
Unredacted emails and other correspondence within the NARA FOIA Office. b. Unredacted emails and other
correspondence within the NARA Media or Public Affairs Office or similar office by any other name. c. Unredacted
emails and other correspondence between the NARA FOAI Office with any other office, including NARA’s Media or
Public Affairs Office or similar office by any other name. d. Records of reviews conducted of the subject matter of the
request for expedited processing and the dedision to deny expedited processing 2. I am also seeking a copy of this
FOIA Request, which is an Agency record subject to FOIA that exists and is in the Agency’s possession at the time of my
FOIA request. This record is a responsive record integral to my Request. Release of the Agency’s copy is not optional.
REQUESTED FORMAT. I am also seeking records in their native format (MS. Outlook, PowerPoint, Excel, ADA accessible
PDF files by return email with: (1) a signed and dated cover letter (citing my personally assigned requester control
number); (2) with record page count for all records released records (3) a copy of this request in your reply. I seek
records via email in PDF format with an imbedded copy of my requests to (1) impede the agency from not addressing
the FOIA Request; (2) impede the Agency from not providing the documents stated in the Agency’s letter reply, and (3)
make it obvious in any subsequent review what the Agency has or has not done. Further, I request that these records
be sent in any digital formats in which they exist (such as PDF and Excel). Under the terms of the E-FOIA Amendments
of 1996, Section 5, if a document exists in electronic format, it must be released in that format upon request. Each
record must be provided as a distinct record in their native format. Emails should be provided as MS Outlook files, if
not encrypted or otherwise unable to be open ed by me. Only if this is not possible, emails should be produced with
their embedded hyperlinked attachments by using the “File => Save as Adobe PDF” command within Outlook or by
other software that produces the same result. I am also seeking the “Description Available to the Public” field I
FOIAonline be set to yes and that all records be released to and viewable in the application by the general Public. The
release type must be set to “Unredacted – Releasable to the General Public: Will be available to the general public,” or
to “Redacted – Releasable to the General Public: Will be available to the general public.” This request is distinctly
separate from any other. Please do not combine this request with any other request in your reply. I am requesting that
each element of the records sought be specifically addressed in the reply. FEE WAIVER/ PUBLIC INTEREST/PUBLIC
RELEASE. Notwithstanding my agreement to pay fees below if my fee waiver is denied, I am seeking a fee waiver due
to significant public interest in this information. The subject of the requested records concerns "the operations or
activities of the government.” The disclosure is "likely to contribute" to an understanding of government operations
or activities. There is no commercial interest. There is significant public interest. AGREEMENT TO PAY FEES. I agree to
pay fees for searching or copying the records up to $25. If the fees exceed this amount please advise me of the cost
before proceeding. I do not believe that there should be any charge for providing these records, as there is public
interest in government operations. I am a private individual not seeking documents for commercial use, such that the
following applies: “No fees may be charged by any DoD Component if the costs of routine collection and processing of
the fee are likely to equal or exceed the amount of the fee. With the exception of requesters seeking documents for a
commercial use, Components shall provide the first two hours of search time, and the first one hundred pages of
duplication without charge.” I would note that because I am requesting an electronic file, there should not be a per
page copy fee. The OMB Guidelines direct that searches for responsive records should be done in the "most efficient
and least expensive manner." See OMB Fee Guidelines, 52 Fed. Reg. at 10,017. As an “all others” requester, I may only
be assessed search and duplication fees and not fees for review. See 32 CFR 286.12 - Schedule of fees. Also, please
note that, should payment become necessary, the Coinage Act of 1965, specifically Section 31 U.S.C. 5103, entitled
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"Legal tender," states: " United States coins and currency (including Federal reserve notes and circulating notes of
Federal reserve banks and national banks) are legal tender for all debts, public charges, taxes, and dues. Foreign gold
or silver coins are not legal tender for debts. ( Pub. L. 97–258, Sept. 13, 1982, 96 Stat. 980 ; Pub. L. 97–452, §1(19), Jan.
12, 1983, 96 Stat. 2477 .) EXPEDITED PROCESSING. I am seeking expedited processing. The subject is of widespread
and exceptional media interest and the information sought involves possible questions about the government's
integrity that affect public confidence. This matter relates to matters before the FOIA Advisory Committee reporting to
the Archivist of the United States, including the inadequacy of OGIS budgets, OGIS Public Comments Posing Policy,
the Mandatory Right to OGIS Dispute Resolution and others. Open meetings are viewed by thousands, including via
permanently preserved You Tube videos. The is extensive public and media interest. Additionally, I am an
individual/organization primarily engaged in the dissemination of information who can prove the information is
urgently needed to inform the public concerning some actual or alleged government activity. My primary activity is
informing the public, which I do through a variety of means, such as open meeting public comments, blogs, etc., and I
may from time to time collaborate on articles. There is extraordinary, off the charts interest in the subject matter of
this meeting and NARA’s execution. DOD POLICY – PUBLIC TRUST. Reference (c) states, “DoD personnel are expected
to comply with the FOIA, this Regulation, and DoD FOIA policy in both letter and spirit. This strict adherence is
necessary to provide uniformity in the implementation of the DoD FOIA Program and to create conditions that will
promote public trust.” STILL-INTERESTED PREEMPTIVE REPLY. This is a preemptive reply to the Justice Department
guidelines the procedure known as a “still interested” inquiry, through which a FOIA officer can confirm that the
requester has not lost interest in obtaining the documents. My interest in all FOIA requests submitted to your office is
enduring, meaning that my interest in seeking replies to all past and future FOIA request remains in effect until each
request has been answered fully and the time for judicial review has passed. Please do not initiate any "still
interested" inquiries. This serves as my notice of enduring interest and automatic reply to any future questions of
interest by your office. There are no reasonable grounds to ever conclude in the future that I am not interested in this
request. Implementation Checklist for DOJ OIP Guidance on “Still-Interested” Inquiries 1. Ensure there are reasonable
grounds to make a “still-interested” inquiry in first instance. 2. Absent good cause, do not make multiple “still-
interested” inquiries. 3. Use requester’s preferred method of communication and in the absence of a preference,
communicate by telephone or email as the default. 4. Memorialize any decision by a requester to withdraw a request
that is conveyed by telephone by sending the requester a brief email or letter noting the withdrawal. 5. Provide
requesters no less than thirty (30) working days to respond to the “still-interested” inquiry and ensure that there is a
simple way to do so. 6. Advise the requester that if they elect not to respond to the inquiry, the request will be
administratively closed at the conclusion of the designated time period (which must be at least 30 working days). 7.
Prior to administratively closing a request based upon the lack of a response by the requester, make good faith efforts
to reach out to the requester using multiple methods of communication. 8. In the event a requester responds to the
“still- interested” inquiry within a reasonable time after the deadline has passed, reopen the request and place it back
into the processing queue where it would have been. PRESERVE RECORDS AND SEARCHES FOR JUDICIAL REVIEW.
Please search for, locate and preserve all responsive or potentially responsive records and records of your searches in
your FOIA case file until the statutory date for judicial review has passed (should that be necessary) or in accordance
with a NARA approved records schedule, if longer. NARA GRS 4.2 requires that FOIA and Privacy Act case files be
retained for 6 years after final agency action or 3 years after final adjudication by the courts, whichever is later.
Records of responsive searches would include but not be limited to: searches conducted for each specific record
sought and all other records known to the Agency, including dates, manner of searching, responsible agent or
employee conducting each search and the results thereof. Such persons determining the locations of responsive
records must be inclusive of persons who would know such locations and their identities and manner of determining
search locations must be preserved. In any subsequent proceedings, I may seek sworn declarations and a court order
appointing a special counsel, as appropriate. ... Fee Waiver Original Justification: FEE WAIVER/ PUBLIC
INTEREST/PUBLIC RELEASE. Notwithstanding my agreement to pay fees below if my fee waiver is denied, I am seeking
a fee waiver due to significant public interest in this information. The subject of the requested records concerns "the
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operations or activities of the government.” The disclosure is "likely to contribute" to an understanding of
government operations or activities. There is no commercial interest. There is significant public interest. AGREEMENT
TO PAY FEES. I agree to pay fees for searching or copying the records up to $25. If the fees exceed this amount please
advise me of the cost before proceeding. I do not believe that there should be any charge for providing these records,
as there is public interest in government operations. I am a private individual not seeking documents for commercial
use, such that the following applies: “No fees may be charged by any DoD Component if the costs of routine collection
and processing of the fee are likely to equal or exceed the amount of the fee. With the exception of requesters seeking
documents for a commercial use, Components shall provide the first two hours of search time, and the first one
hundred pages of duplication without charge.” I would note that because I am requesting an electronic file, there
should not be a per page copy fee. The OMB Guidelines direct that searches for responsive records should be done in
the "most efficient and least expensive manner." See OMB Fee Guidelines, 52 Fed. Reg. at 10,017. As an “all others”
requester, I may only be assessed search and duplication fees and not fees for review. See 32 CFR 286.12 - Schedule of
fees. Also, please note that, should payment become necessary, the Coinage Act of 1965, specifically Section 31 U.S.C.
5103, entitled "Legal tender," states: " United States coins and currency (including Federal reserve notes and
circulating notes of Federal reserve banks and national banks) are legal tender for all debts, public charges, taxes, and
dues. Foreign gold or silver coins are not legal tender for debts. ( Pub. L. 97–258, Sept. 13, 1982, 96 Stat. 980 ; Pub. L.
97–452, §1(19), Jan. 12, 1983, 96 Stat. 2477 .) EXPEDITED PROCESSING. I am seeking expedited processing. The
subject is of widespread and exceptional media interest and the information sought involves possible questions
about the government's integrity that affect public confidence. This matter relates to matters before the FOIA
Advisory Committee reporting to the Archivist of the United States, including the inadequacy of OGIS budgets, OGIS
Public Comments Posing Policy, the Mandatory Right to OGIS Dispute Resolution and others. Open meetings are
viewed by thousands, including via permanently preserved You Tube videos. The is extensive public and media
interest. Additionally, I am an individual/organization primarily engaged in the dissemination of information who can
prove the information is urgently needed to inform the public concerning some actual or alleged government activity.
My primary activity is informing the public, which I do through a variety of means, such as open meeting public
comments, blogs, etc., and I may from time to time collaborate on articles. There is extraordinary, off the charts
interest in the subject matter of this meeting and NARA’s execution. Fee Waiver Disposition Reason: N/A

FOIA Request NARA-NGC-2022-000165 Modified System 12/01/2021

The FOIA request - NARA-NGC-2022-000165 has been supplemented with additional supporting files. Additional
details for this item are as follows: Tracking Number: NARA-NGC-2022-000165 Requester: Mr. robert hammond
Submitted Date: 11/05/2021 Description: FOIA Request NARA 22-M Expedited Processing NARA-NGC-2022-000028. See
PDF. I am respectfully seeking: 1. Records from 7 October 2021 to 15 October 2021 related to the NARA decision to
deny expedited processing for this subject case, FOIAonline NARA-NGC-2022-000028. Records would include, but not
be limited to: a. Unredacted emails and other correspondence within the NARA FOIA Office. b. Unredacted emails and
other correspondence within the NARA Media or Public Affairs Office or similar office by any other name. c.
Unredacted emails and other correspondence between the NARA FOAI Office with any other office, including NARA’s
Media or Public Affairs Office or similar office by any other name. d. Records of reviews conducted of the subject
matter of the request for expedited processing and the dedision to deny expedited processing 2. I am also seeking a
copy of this FOIA Request, which is an Agency record subject to FOIA that exists and is in the Agency’s possession at
the time of my FOIA request. This record is a responsive record integral to my Request. Release of the Agency’s copy is
not optional. REQUESTED FORMAT. I am also seeking records in their native format (MS. Outlook, PowerPoint, Excel,
ADA accessible PDF files by return email with: (1) a signed and dated cover letter (citing my personally assigned
requester control number); (2) with record page count for all records released records (3) a copy of this request in your
reply. I seek records via email in PDF format with an imbedded copy of my requests to (1) impede the agency from not
addressing the FOIA Request; (2) impede the Agency from not providing the documents stated in the Agency’s letter
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reply, and (3) make it obvious in any subsequent review what the Agency has or has not done. Further, I request that
these records be sent in any digital formats in which they exist (such as PDF and Excel). Under the terms of the E-FOIA
Amendments of 1996, Section 5, if a document exists in electronic format, it must be released in that format upon
request. Each record must be provided as a distinct record in their native format. Emails should be provided as MS
Outlook files, if not encrypted or otherwise unable to be open ed by me. Only if this is not possible, emails should be
produced with their embedded hyperlinked attachments by using the “File => Save as Adobe PDF” command within
Outlook or by other software that produces the same result. I am also seeking the “Description Available to the
Public” field I FOIAonline be set to yes and that all records be released to and viewable in the application by the
general Public. The release type must be set to “Unredacted – Releasable to the General Public: Will be available to
the general public,” or to “Redacted – Releasable to the General Public: Will be available to the general public.” This
request is distinctly separate from any other. Please do not combine this request with any other request in your reply.
I am requesting that each element of the records sought be specifically addressed in the reply. FEE WAIVER/ PUBLIC
INTEREST/PUBLIC RELEASE. Notwithstanding my agreement to pay fees below if my fee waiver is denied, I am seeking
a fee waiver due to significant public interest in this information. The subject of the requested records concerns "the
operations or activities of the government.” The disclosure is "likely to contribute" to an understanding of
government operations or activities. There is no commercial interest. There is significant public interest. AGREEMENT
TO PAY FEES. I agree to pay fees for searching or copying the records up to $25. If the fees exceed this amount please
advise me of the cost before proceeding. I do not believe that there should be any charge for providing these records,
as there is public interest in government operations. I am a private individual not seeking documents for commercial
use, such that the following applies: “No fees may be charged by any DoD Component if the costs of routine collection
and processing of the fee are likely to equal or exceed the amount of the fee. With the exception of requesters seeking
documents for a commercial use, Components shall provide the first two hours of search time, and the first one
hundred pages of duplication without charge.” I would note that because I am requesting an electronic file, there
should not be a per page copy fee. The OMB Guidelines direct that searches for responsive records should be done in
the "most efficient and least expensive manner." See OMB Fee Guidelines, 52 Fed. Reg. at 10,017. As an “all others”
requester, I may only be assessed search and duplication fees and not fees for review. See 32 CFR 286.12 - Schedule of
fees. Also, please note that, should payment become necessary, the Coinage Act of 1965, specifically Section 31 U.S.C.
5103, entitled "Legal tender," states: " United States coins and currency (including Federal reserve notes and
circulating notes of Federal reserve banks and national banks) are legal tender for all debts, public charges, taxes, and
dues. Foreign gold or silver coins are not legal tender for debts. ( Pub. L. 97–258, Sept. 13, 1982, 96 Stat. 980 ; Pub. L.
97–452, §1(19), Jan. 12, 1983, 96 Stat. 2477 .) EXPEDITED PROCESSING. I am seeking expedited processing. The
subject is of widespread and exceptional media interest and the information sought involves possible questions
about the government's integrity that affect public confidence. This matter relates to matters before the FOIA
Advisory Committee reporting to the Archivist of the United States, including the inadequacy of OGIS budgets, OGIS
Public Comments Posing Policy, the Mandatory Right to OGIS Dispute Resolution and others. Open meetings are
viewed by thousands, including via permanently preserved You Tube videos. The is extensive public and media
interest. Additionally, I am an individual/organization primarily engaged in the dissemination of information who can
prove the information is urgently needed to inform the public concerning some actual or alleged government activity.
My primary activity is informing the public, which I do through a variety of means, such as open meeting public
comments, blogs, etc., and I may from time to time collaborate on articles. There is extraordinary, off the charts
interest in the subject matter of this meeting and NARA’s execution. DOD POLICY – PUBLIC TRUST. Reference (c) states,
“DoD personnel are expected to comply with the FOIA, this Regulation, and DoD FOIA policy in both letter and spirit.
This strict adherence is necessary to provide uniformity in the implementation of the DoD FOIA Program and to create
conditions that will promote public trust.” STILL-INTERESTED PREEMPTIVE REPLY. This is a preemptive reply to the
Justice Department guidelines the procedure known as a “still interested” inquiry, through which a FOIA officer can
confirm that the requester has not lost interest in obtaining the documents. My interest in all FOIA requests submitted
to your office is enduring, meaning that my interest in seeking replies to all past and future FOIA request remains in
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effect until each request has been answered fully and the time for judicial review has passed. Please do not initiate
any "still interested" inquiries. This serves as my notice of enduring interest and automatic reply to any future
questions of interest by your office. There are no reasonable grounds to ever conclude in the future that I am not
interested in this request. Implementation Checklist for DOJ OIP Guidance on “Still-Interested” Inquiries 1. Ensure
there are reasonable grounds to make a “still-interested” inquiry in first instance. 2. Absent good cause, do not make
multiple “still-interested” inquiries. 3. Use requester’s preferred method of communication and in the absence of a
preference, communicate by telephone or email as the default. 4. Memorialize any decision by a requester to
withdraw a request that is conveyed by telephone by sending the requester a brief email or letter noting the
withdrawal. 5. Provide requesters no less than thirty (30) working days to respond to the “still-interested” inquiry and
ensure that there is a simple way to do so. 6. Advise the requester that if they elect not to respond to the inquiry, the
request will be administratively closed at the conclusion of the designated time period (which must be at least 30
working days). 7. Prior to administratively closing a request based upon the lack of a response by the requester, make
good faith efforts to reach out to the requester using multiple methods of communication. 8. In the event a requester
responds to the “still- interested” inquiry within a reasonable time after the deadline has passed, reopen the request
and place it back into the processing queue where it would have been. PRESERVE RECORDS AND SEARCHES FOR
JUDICIAL REVIEW. Please search for, locate and preserve all responsive or potentially responsive records and records
of your searches in your FOIA case file until the statutory date for judicial review has passed (should that be
necessary) or in accordance with a NARA approved records schedule, if longer. NARA GRS 4.2 requires that FOIA and
Privacy Act case files be retained for 6 years after final agency action or 3 years after final adjudication by the courts,
whichever is later. Records of responsive searches would include but not be limited to: searches conducted for each
specific record sought and all other records known to the Agency, including dates, manner of searching, responsible
agent or employee conducting each search and the results thereof. Such persons determining the locations of
responsive records must be inclusive of persons who would know such locations and their identities and manner of
determining search locations must be preserved. In any subsequent proceedings, I may seek sworn declarations and
a court order appointing a special counsel, as appropriate. ...

FOIA Request NARA-NGC-2022-000165 Modified System 12/01/2021

The FOIA request - NARA-NGC-2022-000165 has been supplemented with additional supporting files. Additional
details for this item are as follows: Tracking Number: NARA-NGC-2022-000165 Requester: Mr. robert hammond
Submitted Date: 11/05/2021 Description: FOIA Request NARA 22-M Expedited Processing NARA-NGC-2022-000028. See
PDF. I am respectfully seeking: 1. Records from 7 October 2021 to 15 October 2021 related to the NARA decision to
deny expedited processing for this subject case, FOIAonline NARA-NGC-2022-000028. Records would include, but not
be limited to: a. Unredacted emails and other correspondence within the NARA FOIA Office. b. Unredacted emails and
other correspondence within the NARA Media or Public Affairs Office or similar office by any other name. c.
Unredacted emails and other correspondence between the NARA FOAI Office with any other office, including NARA’s
Media or Public Affairs Office or similar office by any other name. d. Records of reviews conducted of the subject
matter of the request for expedited processing and the dedision to deny expedited processing 2. I am also seeking a
copy of this FOIA Request, which is an Agency record subject to FOIA that exists and is in the Agency’s possession at
the time of my FOIA request. This record is a responsive record integral to my Request. Release of the Agency’s copy is
not optional. REQUESTED FORMAT. I am also seeking records in their native format (MS. Outlook, PowerPoint, Excel,
ADA accessible PDF files by return email with: (1) a signed and dated cover letter (citing my personally assigned
requester control number); (2) with record page count for all records released records (3) a copy of this request in your
reply. I seek records via email in PDF format with an imbedded copy of my requests to (1) impede the agency from not
addressing the FOIA Request; (2) impede the Agency from not providing the documents stated in the Agency’s letter
reply, and (3) make it obvious in any subsequent review what the Agency has or has not done. Further, I request that
these records be sent in any digital formats in which they exist (such as PDF and Excel). Under the terms of the E-FOIA
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Amendments of 1996, Section 5, if a document exists in electronic format, it must be released in that format upon
request. Each record must be provided as a distinct record in their native format. Emails should be provided as MS
Outlook files, if not encrypted or otherwise unable to be open ed by me. Only if this is not possible, emails should be
produced with their embedded hyperlinked attachments by using the “File => Save as Adobe PDF” command within
Outlook or by other software that produces the same result. I am also seeking the “Description Available to the
Public” field I FOIAonline be set to yes and that all records be released to and viewable in the application by the
general Public. The release type must be set to “Unredacted – Releasable to the General Public: Will be available to
the general public,” or to “Redacted – Releasable to the General Public: Will be available to the general public.” This
request is distinctly separate from any other. Please do not combine this request with any other request in your reply.
I am requesting that each element of the records sought be specifically addressed in the reply. FEE WAIVER/ PUBLIC
INTEREST/PUBLIC RELEASE. Notwithstanding my agreement to pay fees below if my fee waiver is denied, I am seeking
a fee waiver due to significant public interest in this information. The subject of the requested records concerns "the
operations or activities of the government.” The disclosure is "likely to contribute" to an understanding of
government operations or activities. There is no commercial interest. There is significant public interest. AGREEMENT
TO PAY FEES. I agree to pay fees for searching or copying the records up to $25. If the fees exceed this amount please
advise me of the cost before proceeding. I do not believe that there should be any charge for providing these records,
as there is public interest in government operations. I am a private individual not seeking documents for commercial
use, such that the following applies: “No fees may be charged by any DoD Component if the costs of routine collection
and processing of the fee are likely to equal or exceed the amount of the fee. With the exception of requesters seeking
documents for a commercial use, Components shall provide the first two hours of search time, and the first one
hundred pages of duplication without charge.” I would note that because I am requesting an electronic file, there
should not be a per page copy fee. The OMB Guidelines direct that searches for responsive records should be done in
the "most efficient and least expensive manner." See OMB Fee Guidelines, 52 Fed. Reg. at 10,017. As an “all others”
requester, I may only be assessed search and duplication fees and not fees for review. See 32 CFR 286.12 - Schedule of
fees. Also, please note that, should payment become necessary, the Coinage Act of 1965, specifically Section 31 U.S.C.
5103, entitled "Legal tender," states: " United States coins and currency (including Federal reserve notes and
circulating notes of Federal reserve banks and national banks) are legal tender for all debts, public charges, taxes, and
dues. Foreign gold or silver coins are not legal tender for debts. ( Pub. L. 97–258, Sept. 13, 1982, 96 Stat. 980 ; Pub. L.
97–452, §1(19), Jan. 12, 1983, 96 Stat. 2477 .) EXPEDITED PROCESSING. I am seeking expedited processing. The
subject is of widespread and exceptional media interest and the information sought involves possible questions
about the government's integrity that affect public confidence. This matter relates to matters before the FOIA
Advisory Committee reporting to the Archivist of the United States, including the inadequacy of OGIS budgets, OGIS
Public Comments Posing Policy, the Mandatory Right to OGIS Dispute Resolution and others. Open meetings are
viewed by thousands, including via permanently preserved You Tube videos. The is extensive public and media
interest. Additionally, I am an individual/organization primarily engaged in the dissemination of information who can
prove the information is urgently needed to inform the public concerning some actual or alleged government activity.
My primary activity is informing the public, which I do through a variety of means, such as open meeting public
comments, blogs, etc., and I may from time to time collaborate on articles. There is extraordinary, off the charts
interest in the subject matter of this meeting and NARA’s execution. DOD POLICY – PUBLIC TRUST. Reference (c) states,
“DoD personnel are expected to comply with the FOIA, this Regulation, and DoD FOIA policy in both letter and spirit.
This strict adherence is necessary to provide uniformity in the implementation of the DoD FOIA Program and to create
conditions that will promote public trust.” STILL-INTERESTED PREEMPTIVE REPLY. This is a preemptive reply to the
Justice Department guidelines the procedure known as a “still interested” inquiry, through which a FOIA officer can
confirm that the requester has not lost interest in obtaining the documents. My interest in all FOIA requests submitted
to your office is enduring, meaning that my interest in seeking replies to all past and future FOIA request remains in
effect until each request has been answered fully and the time for judicial review has passed. Please do not initiate
any "still interested" inquiries. This serves as my notice of enduring interest and automatic reply to any future
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questions of interest by your office. There are no reasonable grounds to ever conclude in the future that I am not
interested in this request. Implementation Checklist for DOJ OIP Guidance on “Still-Interested” Inquiries 1. Ensure
there are reasonable grounds to make a “still-interested” inquiry in first instance. 2. Absent good cause, do not make
multiple “still-interested” inquiries. 3. Use requester’s preferred method of communication and in the absence of a
preference, communicate by telephone or email as the default. 4. Memorialize any decision by a requester to
withdraw a request that is conveyed by telephone by sending the requester a brief email or letter noting the
withdrawal. 5. Provide requesters no less than thirty (30) working days to respond to the “still-interested” inquiry and
ensure that there is a simple way to do so. 6. Advise the requester that if they elect not to respond to the inquiry, the
request will be administratively closed at the conclusion of the designated time period (which must be at least 30
working days). 7. Prior to administratively closing a request based upon the lack of a response by the requester, make
good faith efforts to reach out to the requester using multiple methods of communication. 8. In the event a requester
responds to the “still- interested” inquiry within a reasonable time after the deadline has passed, reopen the request
and place it back into the processing queue where it would have been. PRESERVE RECORDS AND SEARCHES FOR
JUDICIAL REVIEW. Please search for, locate and preserve all responsive or potentially responsive records and records
of your searches in your FOIA case file until the statutory date for judicial review has passed (should that be
necessary) or in accordance with a NARA approved records schedule, if longer. NARA GRS 4.2 requires that FOIA and
Privacy Act case files be retained for 6 years after final agency action or 3 years after final adjudication by the courts,
whichever is later. Records of responsive searches would include but not be limited to: searches conducted for each
specific record sought and all other records known to the Agency, including dates, manner of searching, responsible
agent or employee conducting each search and the results thereof. Such persons determining the locations of
responsive records must be inclusive of persons who would know such locations and their identities and manner of
determining search locations must be preserved. In any subsequent proceedings, I may seek sworn declarations and
a court order appointing a special counsel, as appropriate. ...
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